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1.1.- Antecedents 

 

En l'actualitat, encara hi ha moltes regions del món on no hi ha xarxa de subministrament elèctric. En 

les àrees que no arriba la xarxa elèctrica, la població té moltes deficiències en relació a la 

subsistència, i l'evolució de la seva qualitat de vida normalment es veu molt desfasada en relació a 

les àrees en que sí hi ha subministrament elèctric . En aquestes zones, les primeres necessitats són 

bàsiques, i moltes vegades no estan completament cobertes.  

 

La regió que es tractarà en aquest projecte és la regió de l'Himàlaia Indi. En aquesta zona geogràfica, 

la població sobreviu gràcies a l'agricultura i són economies bàsiques de subsistència. L'aspecte positiu 

d'aquesta zona en particular, és que l'aigua hi és en abundància. Al ser un recurs natural i gratuït, i en 

aquesta zona en particular, molt abundant, ofereix una possibilitat idònia per a explotar.  

 

Fins a l'actualitat, la població himàlaienca ha construït les seves pròpies turbines artesanals per a 

poder explotar aquest recurs natural. La fabricació d'aquestes turbines es fa gràcies als seus propis 

recursos materials, i és totalment artesanal. 

 

Des de llavors, les turbines picohidràuliques d'impulsió de baixa velocitat s'utilitzen massivament en 

zones rurals de l'Himàlaia indi. La seva fabricació rudimentària comporta diversos problemes, entre 

ells: baix rendiment, baixa resistència i baixa durabilitat. Aquests problemes limiten molt l'ús de les 

turbines a aplicacions molt específiques com per exemple, moldre gra. 

 

Una millora considerable en la seva eficiència permetria disposar d'una font gratuïta d'energia 

mecànica, pràcticament contínua i estable durant tot l'any, que permetria el pas d'una economia de 

subsistència a una economia bàsica de mercat. Aquest pas tecnològic suposaria una millora 

considerable en la qualitat de vida de la població: es podria moldre més gra i més ràpidament, 

permetent un augment de la producció, amb la possibilitat de generar un excedent de producció, 

apte per a ser venut. També es podria començar a generar energia elèctrica acoblant un petit 

generador per cobrir les necessitats elèctriques més bàsiques, com és l'enllumenat. 

 

L'UNESCO va voler substituir les turbines actuals per a unes de més sofisticades, (turbines Francis, 

Annex A) però no es va aconseguir, ja que quan les turbines precisaven de manteniment, la població 

no disposava de recanvis, ni els podia aconseguir. 
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1.2.- Objecte del projecte 

 

L'objecte del projecte és millorar el disseny hidràulic de les turbines picohidràuliques d'impulsió 

emprades en l'Himàlaia indi.  

 

Per tal d'augmentar el rendiment hidràulic de les turbines, primerament s'establirà una metodologia 

per obtenir les corbes d'una turbina real que disposem en el laboratori de mecànica de fluids de la 

Universitat de Girona. S'ha d'establir aquesta metodologia, perquè no és possible disposar de les 

corbes característiques de la turbina tradicional. Les corbes es definiran amb l'ajuda de programari 

de dinàmica de fluids computacional (CFD) (Capítol 3). A continuació  es validarà l'anterior 

metodologia comparant amb les dades reals de camp.  

 

Una vegada validat (Capítol 4), el mètode de simulació s'aplicarà a la morfologia de les turbines 

existents a l'Himàlaia per determinar les condicions actuals de treball (Capítol 5). Un cop 

determinades les condicions actuals de treball, es proposarà un disseny diferent d'àlep, per obtenir 

una millora rellevant en el rendiment de la turbina (Capítol 6). 

 

1.3.- Especificacions i abast 

 

El projecte comprendrà la simulació de la turbina existent en el laboratori de mecànica de fluids de 

l'Escola Politècnica Superior de Girona, per tal de poder efectuar la validació del programari de 

dinàmica de fluids computacional (CFD), i així poder estudiar les turbines utilitzades a l'Himàlaia indi. 

 

Els rendiments de les turbines s'estudiaran amb el software comercial ANSYS-CFX i amb STAR CCM+. 

S'utilitzaran ambdós programes per a comprovar la congruència de resultats entre els dos 

programes. 

 

S'exclou la realització de prototips. 
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PROBLEMA 
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2.1.- Tipus de turbines utilitzades a l'Himàlaia actualment 

 

Les turbines es poden classificar en diversos tipus, segons la seva morfologia i funcionament (Annex 

A). Les turbines utilitzades actualment a l'Himàlaia Indi es podria considerar que pertanyen a la 

família de les turbines Turgo, tot i ser "rodes d'aigua". És evident que les turbines utilitzades a 

l'Himàlaia són de molt baixa tecnificació en comparació a les turbines Turgo que es fabriquen 

industrialment. La Figura 1 mostra els plànols simplificats de les turbines que s'estan utilitzant 

actualment a l'Himàlaia. La Figura 2 mostra una petita turbina Turgo fabricada industrialment. 

 

 

 

Figura 1.- Croquis de les turbines de l'Himàlaia 
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Figura 2.- Rodet d'una turbina Turgo 

(http://www.cerpch.unifei.edu.br/sp/turgo.php) 

 

És necessari esmentar que les turbines existents a l'Himàlaia i els plànols d'aquestes, possiblement 

difereixin en relació a mides i alineació dels àleps, degut a que és la mateixa població la que les 

fabrica i repara. Per tant, si les turbines són manipulades per un personal no qualificat, el rendiment i 

prestacions d'aquestes pot baixar considerablement. 

 

2.2.- Problemàtica de les turbines actuals  

 

Les turbines que s'utilitzen actualment a  l'Himàlaia, presenten una sèrie d'inconvenients: 

 

 1.- Baixos rendiments degut a factors com: baixa complexitat de les turbines, cabals no 

 controlats, operaris poc qualificats, tècniques rudimentàries de fabricació i manipulació, 

 entre d'altres. 

 2.- Desenvolupament nul. No s'ha intentat millorar el rendiment de les turbines. 

 3.- Materials poc resistents, com per exemple fusta, que pateix podriments i ruptures. 

 4.- El cabal d'aigua que va cap a la turbina, normalment no és filtrat, i per tant entren petites 

 pedres i matèria diversa que provoca un desgast més ràpid del conjunt. 

 5.-L'energia obtinguda és molt escassa, i per tant l'ús de les turbines queda molt limitat a 

 certs usos. 
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2.3.- Justificació de la solució i metodologia 

   

La solució que es proposarà serà vàlida perquè s'estudiarà el comportament de les turbines amb el 

programa comercial Ansys Workbench. El programa Ansys Workbench és un programa de CFD que 

porta molt de temps en continu desenvolupament, aconseguint uns resultats molt acurats. Tot i així, 

els resultats obtinguts es compararan amb els d'un altre programa comercial, l'Star-CCM+. L'STAR-

CCM+ és un altre programa de CFD, competència de l'Ansys Workbench. Al ser dos programes de 

simulació de fluids (Capítol 3) de diferents fabricants, s'entén que si ambdós solucions coincideixen, 

el procediment per realitzar les simulacions haurà estat correcte. 

 

Al ser dos programes de diferents fabricants, la configuració dels diferents paràmetres i condicions 

de contorn és bastant diferent. En el cas que a l'hora de configurar les condicions de contorn, per 

error, ens equivoquéssim, els resultats de les simulacions serien molt diferents, i per tant seria fàcil 

reconèixer que a les configuracions de les simulacions hi ha alguna errada. És per això que alhora de 

configurar els Setups de les simulacions s'ha anat amb molta cura i precaució (Annexos D i E).  

 

A més, primerament es simularà una altra turbina picohidràulica que es troba en el laboratori de 

mecànica de fluids de la Universitat de Girona. D'aquesta turbina en tenim les dades reals de camp, 

degut a estudis anteriors al present projecte. És per aquest motiu que es podrà comparar entre la 

solució donada per ambdós programaris i la realitat. Així podrem comprovar el correcte 

funcionament dels programes alhora de resoldre problemes de simulació de fluids. Aquest procés és 

anomenat com a "validació del programari". Aquesta validació és necessària per tenir la completa 

seguretat que els programes donen solucions vàlides/reals (Capítol 4). 

 

Finalment, si les solucions obtingudes pels programes informàtics i les dades reals de camp diferissin 

molt, s'haurien de reconfigurar les simulacions per tal d'apropar les simulacions a la realitat, i així 

poder considerar els resultats de la turbina de l'Himàlaia vàlids. 
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2.4.- Esquema de resolució del problema   

 

Els passos que es seguiran per a resoldre el problema i donar una solució, es poden resumir en 

l'esquema que mostra la Figura 3: 

 

 

Figura 3. Esquema del procés que es seguirà per donar solució al problema 
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Primerament es seguirà l'esquema de la Figura 3 per a la simulació i estudi de la turbina del 

laboratori de mecànica de fluids de la Universitat de Girona (Capítol 4). Un cop comparats els valors 

reals de camp i les solucions obtingudes, es seguirà el mateix procés per a l'estudi de les turbines de 

l'Himàlaia. Havent obtingut els valors de les turbines de l'Himàlaia, es faran uns gràfics de potència i 

parell actuals  que correspondran a les corbes característiques de la màquina tradicional(Capítol 5).  

 

Finalment, es tornarà a fer el mateix procés amb la proposta de turbina millorada, obtenint els 

gràfics de potència i parell. Un cop es tinguin totes les dades, es compararan els valors actuals, amb 

els valors que es podrien assolir si és fessin les modificacions que més endavant es proposaran 

(Capítol 6). 

 

Val a dir, que per a poder realitzar les corbes característiques de cada turbina que s'estudiarà, 

s'hauran de fer simulacions amb les mateixes condicions de contorn, exceptuant la velocitat angular 

de la turbina. Les velocitats a les que es farà l'estudi, són les següents: 

 

 - Turbina laboratori: 30, 90, 150, 210, 270, 330 i 390 revolucions per minut. 

 - Turbina Himàlaia: 30, 90, 150, 210 i 270 revolucions per minut. 

 - Turbina Himàlaia modificada: 90, 150, 210 i 270 revolucions per minut. 

 

No s'estudiaran més règims de revolucions perquè el temps que tarda cada simulació és 

aproximadament d'uns 4 dies, i si s'estudiessin més casos, s'allargaria moltíssim el temps de càlcul, ja 

que es disposa d'una quantitat limitada de computadores a l'aula de CFD de l'Escola Politècnica 

Superior de la Universitat de Girona. A més, se sap que els règims de gir d'aquestes turbines estan 

compresos dins dels rangs de velocitat que s'estudiaran. 
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PROGRAMARI CFD  
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3.1.- Introducció 

 

La mecànica de fluids computacional (CFD: Computational Fluid Dynamics) és una de les branques de 

la mecànica de fluids, que utilitza mètodes numèrics i algoritmes per a resoldre i analitzar problemes 

sobre el flux de substàncies. Els ordinadors són utilitzats per realitzar els milions de càlculs requerits 

per a simular la interacció dels líquids i gasos amb superfícies complexes.  

 

Tot i utilitzar equacions simplificades i ordinadors amb grans capacitats, en molts casos, els resultats 

són només aproximats. Tot i així, la contínua investigació ha permès incorporar software que redueix 

la velocitat de càlcul, així com també el marge d'error dels resultats obtinguts. A més, el continu 

desenvolupament de la tecnologia, ha permès analitzar situacions cada vegada més complexes, així 

com fluids transònics i els fluxos turbulents. La verificació dels resultats obtinguts per CFD es sol 

realitzar en túnels de vent o altres models físics a escala. 

 

El mètode consisteix en discretitzar una regió de l'espai creant el que es coneix com a una malla 

espacial, dividint l'espai en petits volums de control (Annex C). Llavors, es resol en cada un d'ells les 

equacions de conservació discretitzades, de forma que en realitat, s'estan resolent unes equacions 

algebraiques per a tot el volum, de forma iterativa, fins que el residu és suficientment petit (de 

l'ordre de 1·10-5).  

 

A la Figura 4 es pot veure una malla, amb els corresponents nodes i cel·les. 

 

 

Figura 4. Exemple de malla on es poden apreciar els nodes (punts d'unió) i cel·les. 



 

Millora del rendiment hidràulic d'una turbina picohidràulica Memòria i annexos 

17 
 

 

3.2.- Simulació CFD de turbines hidràuliques 

 

En el mercat hi ha diversos programes CFD, i cadascun té les seves pròpies particularitats, però el que 

tots comparteixen és l'estructura del procés a seguir alhora d'efectuar les simulacions. L'esquema 

bàsic es mostra a la Figura 5. 

 

 

 

Figura 5. Esquema a seguir per fer simulacions amb programàri d'elements finits 
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El primer pas consisteix en representar les geometries que es volen estudiar (Annex B). Aquesta 

primera etapa la podem realitzar amb diferents programes, que poden estar, o no, relacionats amb el 

programari CFD. En el present cas, s'ha optat per representar les geometries en Autocad Inventor 

2012, per la seva senzillesa d'utilització, tot i que també es podia haver utilitzat el subprograma 

Design Modeller de la plataforma Ansys Workbench. A banda d'aquests, també es poden utilitzar 

altres programes tals com el Rhinoceros i el SolidWorks. En aquest apartat, s'inclou la generació de la 

turbina i la generació de la trajectòria que seguirà el fluid objecte d'estudi, en aquest cas, aigua. La 

Figura 6 mostra la turbina del laboratori de fluidomecànica de la Universitat de Girona, representada 

amb l'Autodesk Inventor 2012. 

 

 

 

Figura 6. Representació de la turbina i el doll d'aigua amb Autodesk Inventor 2012. 
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Llavors, hem de definir volums de control (Annex B), perquè, normalment, en la simulació de 

turbines hi interactuen dos tipus de fluids: aigua i aire, i s'ha de contemplar el seu comportament. Es 

crearan 2 volums de control, un que comprengui només la turbina, i un altre que comprengui un 

volum més extens d'espai. El volum de control que comprendrà la turbina servirà per analitzar 

acuradament el que succeeix al voltant de la turbina, i per a més endavant poder-li donar unes 

condicions de contorn diferents a les de l'altre volum de control (Annex D). La Figura 7 mostra els dos 

volums de control i la trajectòria de l'aigua. 

 

 

Figura 7. Imatge on es poden diferenciar els dos volums de control, així com el rodet. 

 Realitzat amb la plataforma Design Modeller de l'Ansys Workbench. 

 

Una vegada definits els volums de control i les geometries, s'ha de mallar el conjunt (Annex C). Cada 

element es mallarà amb unes propietats diferents, en relació a la seva importància en els resultats. 

Tant la turbina com la trajectòria d'aigua es mallaran amb una malla molt fina perquè són les parts 

més importants del conjunt, i qualsevol imprecisió  en aquests dos elements podria derivar en una 

alteració considerable dels resultats. En canvi, el volum de control que engloba tot el conjunt, es pot 

mallar amb cel·les més grans perquè la seva influència en el resultat és molt menor. Cal mencionar 

que en les superfícies de contacte entre volums, la malla també ha de ser fina per tal de no tenir 

irregularitats entre volums. La Figura 8 mostra una de les malles realitzades per a estudiar la turbina 

del laboratori de fluidomecànica de la Universitat de Girona. A la figura 8 es pot apreciar que cada 

zona està mallada diferent segons la seva rellevància en els càlculs. 
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Figura 8. Exemple de malla realitzada l'Ansys Workbench 

 

 

Seguidament, passarem a indicar les condicions de contorn del nostre experiment (Annex D). 

Aquestes condicions, són condicions físiques, tals com pressió en les diferents superfícies, velocitat 

de l'aigua del doll, rotació de la turbina, etc. En aquest apartat, s'ha de prestar especial atenció 

perquè qualsevol inexactitud o error, ens condicionarà estrictament la solució obtinguda. En aquest 

apartat també es determinarà el número d'iteracions que es realitzaran per segon, així com també es 

determinarà la forma en què volem els resultats, i quin tipus de resultats. En la Figura 9 es pot veure 

un dels passos del Setup, on s'indica la velocitat de rotació de la turbina, entre d'altres. Les 

condicions de contorn queden àmpliament detallades a l'Annex D. 
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Figura 9. Configuració de la velocitat de rotació de la turbina 

 

Després d'haver configurat totes les condicions de contorn que regeixen el nostre experiment, i 

comprovar meticulosament que siguin correctes, podrem procedir a executar la simulació del cas. El 

càlcul és un procés llarg i feixuc, procés que pot tardar varis dies. En el present cas, les simulacions 

han tardat unes 100 hores cadascuna.  

 

Quan l'ordinador acaba de calcular, automàticament genera un fitxer de resultats. Aquest fitxer el 

podrem obrir amb el post processador, que és el bloc encarregat de llegir els resultats i representar-

los gràficament. Per a obtenir els resultats de la manera desitjada s'hauran de fer diverses 

configuracions en aquest mateix bloc (Annex F). Les configuracions poden ser tals com: definir un pla 

perquè es representi la trajectòria del fluid en la secció que produeix aquell pla, determinar els colors 

que són del nostre interès per representar els resultats, o l'instant del temps que ens interessa 

representar, entre d'altres.  Tots aquests resultats es poden passar a altres plataformes, tals com 

l'Excel per fer gràfics o els càlculs que siguin necessaris. A la Figura 10 es pot veure un dels primers 

resultats obtinguts de la turbina del laboratori de fluidomecànica de la Universitat de Girona, 

representats en un pla vertical que s'ha situat just al mig del doll d'aigua. 
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Figura 10. Representació de la fracció d'aigua-aire de la turbina del laboratori de fluidomecànica. 

 

A la Figura 10 es pot veure un dels resultats gràfics de la turbina del laboratori. Aquests resultats 

estan representats en un pla vertical situat just al mig del doll d'aigua. En aquest cas, aquest pla ens 

servirà per representar com interactua l'aigua amb l'aire a mesura que el flux d'aigua avança cap als 

àleps del rodet. El color vermell representa que en aquell punt és tot aigua, i no hi ha presència 

d'aigua. El blau fosc representa just al contrari, és a dir, tot aire, i res d'aigua. A la banda esquerra de 

la Figura 10 es pot veure la llegenda de colors, on s'indica cada color quina fracció d'aigua 

representa. També es  generarà un altre pla horitzontal per a veure la interacció de l'aigua i l'aire des 

d'una vista superior (Annex F). Un cop els resultats s'hagin representat en els plans i condicions 

adients, l'últim pas serà interpretar-los i valorar-los segons la situació del nostre experiment (Capítols 

4, 5, 6 i 7). 

 

 

 

 

 

 

 

 



 

Millora del rendiment hidràulic d'una turbina picohidràulica Memòria i annexos 

23 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAPÍTOL 4. TURBINA  

DEL LABORATORI  
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4.1.-  Introducció 

 

El primer pas del projecte consisteix en assegurar que el programa de simulació utilitzat, l'Ansys 

Workbench 13.0.0 recrea  la situació real. Per comprovar-ho s'utilitzarà una turbina del laboratori de 

fluidomecànica de la Universitat de Girona, de la qual en tenim les corbes característiques i valors de 

funcionament reals gràcies als diferents experiments que s'hi han realitzat amb anterioritat al 

present projecte. Per tal de poder comparar uns valors i altres, s'hauran de fer diverses simulacions 

per poder-ne extreure les corbes característiques "simulades". Es realitzaran simulacions amb 

exactament les mateixes condicions de contorn exceptuant les velocitats de rotació, que seran les 

següents: 30, 90, 150, 210, 270, 330 i 390 revolucions per minut.  A la Figura 11 es pot veure la 

turbina del laboratori de fluidomecànica de la Universitat de Girona, i la Figura 12 es pot veure un 

croquis amb les seves mides totals. 

 

 

Figura 11. Turbina del laboratori de fluidomecànica de la Universitat de Girona 
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Figura 12. Croquis turbina laboratori 

 

Realitzant les primeres simulacions es va comprovar que el bloc de l'Ansys Workbench que es volia 

utilitzar primerament (FLUENT, enlloc de CFX), no podia resoldre malles de més de 512.000 

elements. Les malles que vam establir acceptables, tenien a partir d'un milió i mig d'elements, per 

tant, es van haver de resoldre els casos amb el bloc CFX. 

 

 

4.2.- Error associat al tipus de malla 

 

Si la malla (Annex C) de la geometria és molt basta, aquesta pot comprometre els resultats. Per 

assegurar que la malla és suficientment bona, s'han de fer un seguit de comprovacions. En el present 

cas, s'han generat dues malles diferents per al mateix volum, cadascuna amb el doble d'elements 

que l'anterior. Les característiques de cada malla són les que mostra la Taula 1: 
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Tipus 
Malla 

Trajectòria aigua Volum estàtic Volum mòbil  
Elements 

totals 
malla 

Número 
elements 

Mida 
elements 

Número 
elements 

Mida 
elements 

Número 
elements 

Mida 
elements 

Min Max Min Max Min Max 

Basta 1828 2  
mm 

4 
mm 

482216 4 
 mm 

20 
mm 

612348 5  
mm 

10 
mm 

1096392 

Normal 6624 1 
 mm 

2 
mm 

1068527 2 
 mm 

10 
mm 

934561 2  
mm 

4 
mm 

2009712 

Taula 1. Característiques malles 

 

Per a comprovar que no hi ha error associat al tipus de mallat, es recrearà la mateixa simulació dues 

vegades, però amb les diferents malles. El cas que s'ha utilitzat per a fer la comprovació és el cas de 

150 revolucions per minut en la turbina del laboratori de fluidomecànica de la Universitat de Girona. 

La Figura 13 mostra la comparació entre els parells d'ambdós simulacions. 

 

 

Figura 13. Comparació dels parells entre malla fina i malla normal 

 

En el gràfic, el parell apareix amb signe negatiu simplement per una qüestió d'eixos. Segons el 

sistema d'eixos de l'Ansys Workbench, la turbina girava en direcció Z negativa, i és per aquest motiu 

el signe negatiu.  
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Les potències mitjanes en ambdós casos han estat de: 

 

 - Malla basta: - 0'4665 Nm 

 - Malla normal: -0'4487 Nm 

 

En aquest cas, l'error relatiu entre ambdós simulacions és el que mostra l'equació 1. 

 

�����	��� = 	
�	���	1 − �	���	2

�	���	1
· 100 = 	

0.4665 − 0.4487

0.4665
· 100 = ����% 

Equació 1. Error relatiu 

 

Aquesta variació és minúscula degut a que la malla normal conté el doble d'elements que la basta, 

tot i que s'ha de tenir en compte alhora d'escollir quina és la precisió que volem en els nostres 

resultats. Per tant, es comprova que l'Ansys Workbench és molt precís independentment de la malla, 

dins d'uns límits. S'ha intentat fer una tercera simulació amb una malla fina, d'uns 4 milions 

d'elements, però degut a problemes de llicències de l'Ansys Workbench, no s'ha pogut simular. 

 

Si comparem la distribució de forces Y entre els dos casos de la Figura 14, les diferències són 

mínimes. La força en direcció Y, en aquest cas, és la que dóna parell rotatiu a la turbina. La Figura 15 

mostra les fraccions d'aigua - aire a cada cas, i les diferències també són poc rellevants. 

 

        

Figura 14.- Distribució forces Y. a) malla basta  b) malla normal 

 

 

 

 

 

A B 
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Figura 15. Fracció d'aire-aigua. a) malla basta  b) malla normal 

 

Finalment s'ha optat per fer les simulacions amb unes malles equivalents a la malla normal en cada 

cas per diverses raons: 

 

 - Els valors de la simulació amb la malla normal són més baixos, i es prefereix obtenir uns 

 valors més baixos, amb la possibilitat que a la realitat siguin majors, enlloc  que pugui ocórrer 

 el contrari. 

 - El temps de simulació amb la malla normal és acceptable (uns 4-5 dies depenent de 

 l'ordinador). 

 - La variació de resultats amb una possible malla fina, s'estima que seria d'entre el 2-5%, i 

 comportaria un allargament considerable en el temps de càlcul (10 dies aproximadament). 

 

4.3.- Simulació turbina laboratori 

 

Un cop la computadora ha calculat fins a arribar a un número d'iteracions suficient com perquè els 

residuals siguin prou petits, es podran recollir els resultats per començar a operar amb ells. A la 

Figura 16, es mostren els residuals que es van obtenir per a la simulació de la turbina del laboratori a 

210 revolucions per minut. En tots els altres casos, s'ha deixat calcular a la computadora fins que ha 

arribat a uns residuals similars a els que es mostren a la següent figura. És per això, que d'ara 

endavant, no es mostraran més figures amb residuals. 

 

 

 

 

 

 

A B 
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Figura 16. Residuals simulació turbina laboratori 210 rpm. Els residuals de totes les altres simulacions han estat similars als 

que es mostren a la present figura 

 

Els resultats obtinguts per a cada cas són molt nombrosos. Un cop ordenats i havent fet les 

operacions necessàries, podem extreure els resultats que més ens interessin. En el cas de  la turbina 

del laboratori de fluidomecànica de la Universitat de Girona, els resultats numèrics que s'han 

obtingut,  en valor absolut, són els que es mostren a les taules 2 i 3. 

 

Forces mitjanes [N]  

Rev/min X Y Z 

30 3,451 1,670 3,771 

90 3,241 1,588 3,524 

150 2,997 1,506 3,240 

210 2,870 1,468 3,092 

270 2,583 1,645 2,851 

330 2,438 1,503 2,572 

390 2,467 1,123 2,324 
Taula 2. Forces mitjanes turbina laboratori UdG. 
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  Moments mitjos [Nm]   

Rev/min X Y Z 

30 0,469 0,242 0,522 

90 0,437 0,228 0,487 

150 0,405 0,212 0,448 

210 0,386 0,215 0,426 

270 0,345 0,246 0,391 

330 0,323 0,234 0,351 

390 0,318 0,192 0,314 
Taula 3. Moments mitjos turbina laboratori UdG. 

 

Els valors que ens interessen més són els que generen moviment a la turbina. Respecte a les forces, 

les components que generen parell són la Y principalment, i en part la X. Respecte als moments, els 

valors que ens interessen són els corresponents a la component Z. Es pot comprovar que les 

components X i Y dels moments (les que no generen parell del nostre interès) són considerables en 

relació a la component Z. Això significarà una disminució del rendiment hidràulic de la turbina, 

perquè s'està utilitzant parell que no serveix per a fer girar la turbina. 

 

En el Figura 17 es pot comprovar la variació de parell mig per cada règim de revolucions. 

 

 

Figura 17. Corba de parell de la turbina del laboratori de fluidomecànica de la UdG. 
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Amb la corba de parell, es podrà calcular la potència de la turbina, utilitzant l'Equació 2. 

 

���è���		 !" = # · $	 

Equació 2. Càlcul potència turbina 

 

On:  M: Parell [Nm] 

 w: Velocitat angular [rad/s] 

 

Així, amb l'Equació 2 i els valors de la Figura 15, podrem generar la corba de potència que mostra la 

Figura 18. 

 

 

Figura 18. Corba de potència de la turbina del laboratori de fluidomecànica de la Universitat de girona, fins a 390 rpm 

 

A la Figura 18 s'observa que la corba de potència de la turbina no és completa. No s'han fet 

simulacions a règims més elevats de revolucions per minut perquè les turbines de l'Himàlaia no 

arriben a tanta velocitat. Tot i que els resultats d'estudiar la turbina del laboratori a règims més 

elevats de revolucions ens serien útils, no s'han realitzat perquè cada simulació tarda entre 4 i 5 dies,  

i per tant, allargaria molt el procés de càlcul. 

 

Finalment, s'haurà de calcular el rendiment hidràulic de la turbina. El rendiment hidràulic de la 

turbina és calcula a partir de la relació que mostra l'Equació 3. 

 

%��&�'���	 %" =
���è���	

���è���		����&���
· 100 

Equació 3. Rendiment d'una turbina hidràulica 
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La potència incident es calcula tal i com mostra l'Equació 4. 

 

���è���		����&��� =
1

2
· ρ · v2 · Q 

Equació 4. Potència incident 

 

On: 

 ρ = pes específic de l'aigua (1000 Kg/m
3
) 

 v= velocitat del fluid (en el cas de la turbina de laboratori 11.74 m/s) 

 Q= cabal = v·àrea (Ø entrada doll d'agiua = 8 mm) 

 

 

Aplicant l'Equació 4 es troba que la potència incident a la turbina del laboratori de fluidomecànica és 

de 40'6 W. Comparant els valors de potència amb els de potència incident, (Equació 3) podrem 

generar la corba de rendiment que mostra la Figura 19. 

 

 

Figura 19. Corba de rendiment de la turbina del laboratori de fluidomecànica fins a 390 rpm 

 

El valor màxim de rendiment en aquest interval de revolucions és de 31'64% a 390 revolucions per 

minut. És un valor molt baix, degut al mal aprofitament del doll d'aigua incident, tal com s'ha 

comentat anteriorment.  
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 A les imatges obtingudes en el Post

concentra molt en un punt, quan seria millor que es repartís uniformement 

l'àlep. La Figura 20 mostra la distribució de forces Y sobre l'àlep en diferents règims de revolucions.

Les forces Y són les encarregades de donar parell rotatiu efectiu a la turbina, en aquest cas.

 

Figura 20. Distribució de forces Y 

 

Analitzant les diferents imatges obtingudes de les simulacions de la turbina del laboratori de 

fluidomecànica de la Universitat de Girona es pot observa

d'aigua s'escapa ràpidament cap a l'exterior, i la turbina no aprofita al màxim tota la potència 

disponible.  A la Figura 20 es pot apreciar 

del contorn de velocitats de l

apreciar que l'aigua marxa cap a zones exteriors quan encara té una gran velocitat.

 

 

 

 

 

hidràulic d'una turbina picohidràulica Memòria i annexos

A les imatges obtingudes en el Post-Procés, també s'observa que la distribució de forces es 

concentra molt en un punt, quan seria millor que es repartís uniformement 

mostra la distribució de forces Y sobre l'àlep en diferents règims de revolucions.

Les forces Y són les encarregades de donar parell rotatiu efectiu a la turbina, en aquest cas.

   

    

 quan el doll incideix en el centre de l'àlep. a) 30 rpm b) 90 rpm c) 210 rpm d) 330 rpm

Analitzant les diferents imatges obtingudes de les simulacions de la turbina del laboratori de 

fluidomecànica de la Universitat de Girona es pot observar que a règims baixos de revolucions, 

d'aigua s'escapa ràpidament cap a l'exterior, i la turbina no aprofita al màxim tota la potència 

es pot apreciar aquest comportament. La Figura 2

velocitats de l'aigua i els vectors de velocitat d'aquesta en un pla isomètric. Es pot 

apreciar que l'aigua marxa cap a zones exteriors quan encara té una gran velocitat.

A 

C 

Memòria i annexos 
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Procés, també s'observa que la distribució de forces es 

concentra molt en un punt, quan seria millor que es repartís uniformement sobre la superfície de 

mostra la distribució de forces Y sobre l'àlep en diferents règims de revolucions. 

Les forces Y són les encarregades de donar parell rotatiu efectiu a la turbina, en aquest cas. 

 

 

. a) 30 rpm b) 90 rpm c) 210 rpm d) 330 rpm.  

Analitzant les diferents imatges obtingudes de les simulacions de la turbina del laboratori de 

a règims baixos de revolucions, el flux 

d'aigua s'escapa ràpidament cap a l'exterior, i la turbina no aprofita al màxim tota la potència 

aquest comportament. La Figura 21 és una representació 

'aigua i els vectors de velocitat d'aquesta en un pla isomètric. Es pot 

apreciar que l'aigua marxa cap a zones exteriors quan encara té una gran velocitat. 

B 

D 
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Figura 21. Contorn de velocitats de l'aigua + vectors de direcció de velocitat de la turbina del laboratori de fluidomecànica 

de la UdG a 150 rpm. 

 

 

4.4.- Validació de la simulació  

 

Per establir que les simulacions s'ajusten a la realitat, s'han de comparar els valors obtinguts amb les 

simulacions (Ansys Workench i STAR-CCM+) amb els valors reals de camp. El procés de validació 

contempla una sèrie de passos on es realitzaran una sèrie de comprovacions per tal de validar totes 

les magnituds. Primerament es compararan els moments, tal i com mostra la Figura 22. 
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Figura 22. Comparació de parells reals i simulats 

 

S'observa que entre les corbes de parell de l'Ansys, l'STAR i les dades reals hi ha variacions d'un 1 a 

un 5%, especialment fins a 300 revolucions per minut. A partir d'aquest punt, les corbes es separen. 

En el nostre cas el que interessa és estudiar l'interval de velocitat angular d'entre 0 i 250 revolucions 

per minut, perquè l'interval de funcionament de les turbines de l'Himàlaia és el mateix. La separació 

entre corbes, pot ser deguda a que en les simulacions es va escollir que el comportament de l'aigua 

era de tipus laminar. Es va indicar que era de règim laminar perquè si li indicavem que era turbulent, 

els programes donaven error. Degut a això, els efectes de fricció del fluid amb els àleps no s'han 

tingut en compte, i són més rellevants quan més alta és la velocitat de la turbina. A més, només es va 

generar el rodet de la turbina, quan a la realitat hi ha més elements (eix, rodaments, etc...). S'observa 

que l'Ansys s'aproxima més a la realitat que l'STAR-CCM+, això pot ser degut a que la versió que hi ha 

a les aules de CFD del departament de mecànica de fluids de l'Ansys és més recent que la de l'STAR-

CCM+, i cada nova versió s'ajusta més a la realitat. 
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Seguidament es comprovarà la divergència entre les potències, tal i com mostra la Figura 23. 

 

 

Figura 23. Comparació de potències 

 

En la Figura 23 es pot apreciar exactament el mateix fenomen que el que s'observa en la Figura 22. La 

variació entre la potència real i la potència obtinguda pels resultats de l'Ansys, varia aproximadament 

un 1'5% fins a 270 rpm. En canvi, la potència obtinguda pels resultats de l'STAR, varia un 4'5%. A 

partir de 270 rpm les corbes es separen, per les mateixes raons que les mencionades anteriorment. 

També en aquest cas, s'observa que la corba de l'Ansys s'aproxima més a la realitat que la de l'STAR-

CCM+. 

 

Es dóna la simulació com a vàlida perquè: 

 

 - El règim de funcionament a baixes revolucions és similar tant per el cas real com a la 

 simulació. 

 - La velocitat angular de treball de la turbina real de l'Himàlaia és de 0 a 250 revolucions per 

 minut com a màxim. 

 - El programa que s'utilitzarà per a efectuar les simulacions és l'Ansys Workbench, que 

 nogensmenys és el que s'adapta més a la realitat. 
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CAPÍTOL 5. TURBINA TRADICIONAL 
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5.1.- Introducció 

 

Per a portar a terme l'estudi de les turbines que s'utilitzen actualment a l'Himàlaia, s'han fet diferents 

simulacions amb les mateixes condicions de contorn que les de la turbina del laboratori de 

fluidomecànica de la Universitat de Girona. S'han efectuat simulacions amb unes velocitats angulars 

de la turbina de: 30, 90, 150, 210 i 270 revolucions per minut. 

 

Les turbines de l'Himàlaia podrien treballar a més altes revolucions, però la població que utilitza 

aquest tipus de turbines no els hi interessa augmentar el règim de revolucions. Aquest interès a no 

augmentar les revolucions és degut a que el principal ús al que es destinen les turbines és per a la 

molta de gra per a fer farina, a través d'un eix solidari a la turbina connectat amb una pedra de 

moldre, i si augmenten les revolucions, el gra i la farina queden malmesos. Es prefereix tenir menys 

velocitat i més parell per poder moldre més gra a la vegada. 

 

Segons l'observació de la població que utilitza aquest tipus de turbines, s'ha establert que, per a ells, 

el règim més adequat de revolucions per minut és d'aproximadament 150. 

 

La Taula 4 mostra els elements de la malla de cada volum, i els totals. 

 

 
Tipus 
Malla 

Trajectòria aigua Volum estàtic Volum mòbil 

Número 
elements 

Mida 
elements 

Número 
elements 

Mida 
elements 

Número 
elements 

Mida  
elements 

Min Max Min Max Min Max 

Normal 31489 8 
mm 

12 
mm 

732154 10 
mm 

35 
mm 

778715 10  
mm 

13 
mm 

Total elements malla 1542158 
Taula 4. Elements malla turbina tradicional 

 

 

5.2.- Corba característica 

 

Després de posar a calcular les diferents computadores amb l'Ansys Workbench, els resultats de les 

forces, en valor absolut, que s'han obtingut són els que mostra la Taula 5. 
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Forces mitjanes [N] 

Rev/min X Y Z 

30 886,577 589,367 1009,192 

90 758,392 499,661 838,664 

150 545,008 598,611 839,322 

210 441,645 322,263 470,761 

270 266,021 205,930 331,737 
Taula 5. Forces mitjanes turbina Himàlaia 

 

Els moments mitjos, en valor absolut, que s'han obtingut per a cada règim de revolucions han estat 

els que mostra la Taula 6. 

 

Parell mitjà [Nm] 

Rev/min X Y Z 

30 338,276 51,074 340,377 

90 276,802 42,339 282,281 

150 88,559 275,917 265,867 

210 158,130 19,632 161,203 

270 107,852 22,762 93,862 
Taula 6. Parell mitjà turbina Himàlaia 

 

El sistema d'eixos respecte el cas de la turbina del laboratori de fluidomecànica de la Universitat de 

Girona (Capítol 4) ha variat, degut a que la turbina del laboratori gira a dretes, i la de l'Himàlaia a 

esquerres.  

 

En aquesta situació, la component X de la força és la que genera parell rotatiu sobre l'eix Z.  A la 

Taula 3, es pot veure que la component que genera el moment de rotació de la turbina no és la 

major. La major és la component vertical (Z), degut a que el gran doll d'aigua fa molta força cap avall 

degut a la seva inclinació (45º).  

 

A la Figura 24 es pot observar el comportament del parell Z en funció del règim de revolucions. 

 

 

 



 

Millora del rendiment hidràulic d'una turbina picohidràulica Memòria i annexos 

40 
 

 

 

 

Figura 24. Evolució del parell respecte les revolucions per minut a la turbina de l'Himàlaia 

 

A la corba de parell es veu que aproximadament a 150 revolucions per minut, hi ha una lleugera 

tendència a remuntar el parell. Aquest canvi de trajectòria pot ser degut a que els àleps de la turbina 

tradicional són molt gruixuts, i l'aigua pot impactar a la part posterior de l'àlep, creant així aquesta 

discontinuïtat en la tendència de la corba de parell.  

 

Amb la corba de parell, es podrà calcular la potència de la turbina, utilitzant l'Equació 2 del capítol 4. 

 

Així, amb l'Equació 2 i els valors de la Figura 24, podrem generar la corba de potència que mostra la 

Figura 25. Es pot observar que la màxima potència es situa a prop de les 165 revolucions per minut i  

4200W aproximadament.   
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Figura 25. Potència actual turbina Himàlaia 

 

El rendiment hidràulic de la turbina és calcula a partir de la relació que es mostra a l'Equació 3 del 

capítol 4, i la potència incident es calcula tal i com mostra l'Equació 4 del capítol 4. 

 

Aplicant l'Equació 4 es troba que la potència incident a la turbina de l'Himàlaia és de 7000 W. 

Comparant els valors de potència amb els de potència incident, (Equació 3) podrem generar la corba 

de rendiment que mostra la Figura 26. 

 

 

Figura 26. Rendiment turbina Himàlaia 

 

El punt màxim de rendiment es situa a prop de 165 revolucions per minut amb un 60%. Tot i ésser 

turbines rudimentàries, el rendiment és prou acceptable, tot i que el rendiment d'una turbina tipus 

Turgo pot arribar a valors del 95%. Aquest valor "alt" de rendiment, pot ser degut a que alhora de  
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configurar les condicions de contorn, es va haver d'escollir l'opció flux laminar, i pot ser que al haver 

escollit aquesta opció, hi hagi hagut un augment fictici de rendiment. Val a dir, que aquest augment 

fictici de rendiment, també es donarà en la simulació de la turbina modificada. El que serà realment 

rellevant, és l'increment de rendiment, i és la magnitud d'aquest la que servirà per valorar els 

resultats. A banda d'això, és molt bo que la població utilitzi aquests règims de revolucions per a la 

mòlta de gra, perquè és el punt a on es situa el màxim rendiment. 

 

 

5.3.- Velocitats i forces 

 

A través del post processador de l'Ansys Workbench, s'han pogut treure una sèrie d'imatges a on es 

pot observar el comportament dels dos fluids (aire i aigua) que intervenen en la simulació.  

En les figures 27, 28 i 29 podem observar el comportament de la fracció d'aigua - aire en diferents 

règims de veloctitat angular de la turbina. 

 

 

 
Figura 27. Fracció aire-aigua turbina Himàlaia a 30 rpm quan el doll impacta en el mig de l'àlep 
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Figura 28. Fracció aire-aigua turbina Himàlaia a 90 rpm quan el doll impacta en el mig de l'àlep 

 

 

 
Figura 29. Fracció aire-aigua turbina Himàlaia a 150 rpm quan el doll impacta en el mig de l'àlep 

 

A les figures 27, 28 i 29 es pot comprovar clarament que l'impacte de l'aigua a 30 revolucions per 

minut surt ràpidament cap a endavant, a 90 revolucions per minut l'incidència del doll d'aigua 

comença a ser bona, però tot i així s'escapa cap als àleps consegüents, i a 150 revolucions per minut, 

l'impacte del doll d'aigua és pràcticament perfecte, aconseguint distribuir-se equitativament sobre la 

superfície de l'àlep. L'àlep evacua aproximadament la meitat de l'aigua cap endavant i l'altre meitat 

cap endarrere, aspecte que és molt positiu de cares a la potència i rendiment. Tot i així, cal tenir en 

compte que hi ha una part de l'aigua que impacta amb la part posterior de l'àlep, aspecte que 

possiblement disminueixi el rendiment de la turbina. 
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A la Figura 30 s'observen les diferents trajectòries de les línies d'aigua per a diferents règims de 

revolucions. El punt on canvia la trajectòria i el color de vermell a taronja-groc és allà on impacta 

l'aigua amb l'àlep. Alhora d'obtenir les imatges es va preferir no representar l'àlep perquè si es 

representava quedaven tot un seguit de línies que feien molt difícil la seva interpretació. 

 

 

 

 

Figura 30. Línies de corrent de l'aigua a la turbina de l'Himàlaia. a) 150 rpm  b) 90 rpm 

 

S'aprecia que les línies de corrent a 150 revolucions per minut, formen una trajectòria molt  suau i 

que s'adapta a la forma de l'àlep. En canvi, a 90 revolucions per minut es generen una sèrie de 

turbulències a la part inferior de l'àlep, que impedeixen poder aprofitar al màxim la força de l'aigua.  

 

Finalment, a la Figura 31 es pot veure la distribució de forces X sobre la superfície de l'àlep, en 

diferents règims de revolucions. Les forces X, en aquest cas, són les que donen parell rotatiu efectiu a 

la turbina. 

 

A 

B 
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Figura 31. Distribució de forces X sobre l'àlep de la turbina de l'Himàlaia. a) 30 rpm  b) 150 rpm   c) 210  rpm   

 

A la Figura 31 es pot observar com la distribució de forces sobre la superfície de l'àlep varia molt en 

funció del règim de gir. A 30 rev/min la distribució de forces es situa molt a la part superior de l'àlep, 

mentre que a 150 rev/min, el doll d'aigua aprofita tota la superfície de l'àlep. En canvi, quan 

augmentem una mica més el règim de gir, la distribució de forces tendeix a situar-se cap a la zona 

superior de l'àlep, desaprofitant així tota la força disponible. Les escales de colors de les 3 figures són 

diferents, perquè si les posavem iguals, els casos de 150 i 210 revolucions per minut, no s'apreciava 

correctament la distribució de forces sobre la superfície de l'àlep. 

 

 

 

A B 

C 
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CAPÍTOL 6. PROPOSTA  

DE MILLORA 
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6.1.- Introducció 

 

Per a millorar el rendiment hidràulic de la turbina, s'ha fet una recerca de dissenys d'àleps, perquè 

només substituint els àleps millori el rendiment. És evident que es podrien fer molts altres tipus de 

millores com per exemple, modificar l'angle del canal d'aigua, modificar l'angle dels àleps, o 

simplement fer una nova canalització d'aigua per disposar de dos canals d'entrada d'aigua, o quatre, 

sempre que el material de la turbina (fusta) aguanti. 

 

Finalment es va decidir realitzar les simulacions amb un àlep el perfil del qual té forma similar al 

d'una turbina Turgo. És lògic, ja que la turbina de l'Himàlaia pertany a la família de les turbines Turgo 

(Annex A), i és de suposar que aquest tipus d'àlep té un millor rendiment que les pales rectes. Una 

altra solució, com afegir canals d'aigua, augmentaria la potència, però no el rendiment. A més, 

població himàlaienca pot afegir canals d'entrada, sense necessitat de cap programa CFD. 

 

 El perfil d'àlep amb el que s'han fet les simulacions, és el que mostra la Figura 32. 

 

 

Figura 32. Disseny d'àlep millorat 
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Les mides de l'àlep tipus Turgo que es van trobar, no s'ajustaven a les mides de la turbina de 

l'Himàlaia, i es va tenir que fer un re-escalat per mantenir les proporcions de l'àlep teòric tipus Turgo. 

Respecte a la turbina tradicional, l'àlep és l'únic que s'ha modificat, per tant, el número d'àleps 

segueix essent el mateix (15) i el cos principal té les mateixes mides. 

 

El nou perfil d'àlep estaria fet d'acer, i es podria fabricar en els pobles on hi hagués un ferrer. El ferrer 

fabricaria una matriu amb la forma de l'àlep i la població podria fabricar els àleps fixant planxes 

d'acer a la matriu, i picant amb una massa a la planxa d'acer per donar-li la forma de la matriu. 

Aquestes plaques acabarien en forma punxeguda, per poder anar estampides, gràcies a una massa, a 

dins del cos principal, que és de fusta. Així, es resoldrien els problemes que va tenir l'UNESCO quan 

va intentar substituir les turbines tradicionals. 

 

En la simulació de la turbina amb els àleps modificats, s'ha optat només per estudiar les velocitats 

angulars de 90, 150, 210 i 270 rpm. S'han escollit aquestes velocitats perquè és el rang que interessa 

més estudiar en aquest cas.  

 

La Taula 7 mostra els elements de la malla utilitzada, per cada volum, i els totals. 

 

 
Tipus 
Malla 

Trajectòria aigua Volum estàtic Volum mòbil 

Número 
elements 

Mida 
elements 

Número 
elements 

Mida 
elements 

Número 
elements 

Mida  
elements 

Min Max Min Max Min Max 

Normal 31489 8 
mm 

12 
mm 

715018 10 
mm 

35 
mm 

721775 10  
mm 

13 
mm 

Total elements malla 1468282 
Taula 7. Elements malla turbina tradicional 

 

 

6.2.- Corba característica 

 

Després de posar a calcular les diferents computadores amb l'Ansys Workbench, els resultats de les 

forces, en valor absolut, que s'han obtingut són els que mostra la Taula 8. 
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Forces mitjanes [N]  
Rev/min  X Y Z 

90 842,157 769,193 261,969 

150 678,104 246,484 245,633 

210 521,787 62,801 163,818 

270 152,041 17,249 88,785 
Taula 8. Forces mitjanes turbina Himàlaia modificada 

 

Els moments mitjos, en valor absolut, que s'han obtingut per a cada règim de revolucions han estat 

els que mostra la Taula 9. 

 

 

  Parell mitjà [Nm]   

 Rev/min X Y Z 

90 124,850 11,961 336,576 

150 89,906 19,601 316,159 

210 46,943 15,201 124,369 

270 17,254 24,459 18,666 
Taula 9. Parell mitjà turbina Himàlaia modificada 

 

El sistema d'eixos respecte el cas de la turbina del laboratori de fluidomecànica de la Universitat de 

Girona (Capítol 4) ha variat, degut a que la turbina del laboratori gira a dretes, i la de l'Himàlaia a 

esquerres. En canvi, és el mateix que en el cas de la turbina de l'Himàlaia (Capítol 5). 

 

En aquesta situació, la component X de la força és la que genera parell rotatiu sobre l'eix Z.  A la 

Taula 8, es pot veure que la component que genera el moment de rotació de la turbina és la major.  

 

A la Figura 33 es pot observar el comportament del parell Z en funció del règim de revolucions. 
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Figura 33. Evolució del parell respecte les revolucions per minut a la turbina de l'Himàlaia 

 

A la corba de parell es veu que aproximadament a 150 revolucions per minut, hi ha una lleugera 

tendència a remuntar el parell. Aquest canvi de trajectòria significa que possiblement la màxima 

potència i el màxim rendiment es situïn en aquesta zona. És una bona senyal, ja que el règim de 

funcionament òptim per a la mòlta de gra es situa en aquest règim de revolucions. 

 

Amb la corba de parell, es podrà calcular la potència de la turbina, utilitzant l'Equació 2 del capítol 4. 

 

Així, amb l'Equació 2 i els valors de la Figura 33, podrem generar la corba de potència que mostra la 

Figura 34. Es pot observar que la màxima potència es situa a prop de les 150 revolucions per minut i  

5000W aproximadament.   

 

 
Figura 34. Potència actual turbina Himàlaia 
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El rendiment hidràulic de la turbina és calcula a partir de la relació que es mostra a l'Equació 3 del 

capítol 4 i la potència incident es calcula tal i com mostra l'Equació 4 del capítol 4. 

 

Aplicant l'Equació 4 es troba que la potència incident a la turbina de l'Himàlaia és de 7000 W. 

Comparant els valors de potència amb els de potència incident, (Equació 3) podrem generar la corba 

de rendiment que mostra la Figura 35. 

 

 

Figura 35. Rendiment turbina Himàlaia 

 

El punt màxim de rendiment es situa a prop de 150 revolucions per minut amb un 71%. La millora en 

el rendiment ha estat considerable, només canviant el perfil dels àleps de la turbina. Tot i així, es 

considera que és un rendiment baix, ja que les turbines tipus Turgo, poden arribar a obtenir uns 

rendiments de l'ordre del 95%. 

 

6.3.- Velocitats i forces 

 

Un cop calculats tots els paràmetres, a través del bloc Results del menú principal de l'Ansys 

Workbench, podem extreure informació gràfica (Annex E) per a interpretar els resultats i veure el 

comportament dels fluids que interactuen en la simulació. La Figura 36 mostra les diferents fraccions 

d'aire - aigua en funció del règim de gir de la turbina. 
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Figura 36. Fracció d'aigua de la turbina de l'Himàlaia amb àleps modificats. a) 90 rpm  b) 150 rpm 

 

A la Figura 36 es pot apreciar que a 90 revolucions/minut, el doll d'aigua s'adapta perfectament a 

l'àlep, però a 150 revolucions/min el doll d'aigua agafa més superfície d'àlep. La fracció d'aigua que 

es pot veure a l'àlep de la dreta, correspon al flux d'aigua que abans ha impactat amb aquell àlep, i 

encara no ha caigut. 

 

A la Figura 37 es mostren les línies de corrent en relació a la velocitat angular de la turbina. 

 

   

Figura 37. Línies de corrent de l'aigua. a) 150 rpm  b) 270 rpm 

 

A la Figura 37a s'aprecia que a 150 revolucions per minut, les línies de corrent s'adapten 

perfectament a l'àlep, sense crear cap tipus de turbulència, ni quan l'àlep l'ha expulsat. En canvi, a 

270 revolucions per minut, es veu que l'aigua impacta malament a l'àlep, i és per això que hi ha una 

caiguda de potència en aquest règim de gir. 

 

A la Figura 38 es pot veure la distribució de forces X sobre la superfície dels àleps en diferents règims 

de gir. 

A B 

A B 
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Figura 38. Distribució de forces X sobre l'àlep. a) 150 rpm  b) 210 rpm  

 

A la Figura 38 s'observa que el nou disseny d'àlep és molt eficient a 150 revolucions per minut, ja que 

aprofita la totalitat de la superfície de l'àlep per recollir el doll d'aigua, però en canvi, a revolucions 

més altes, l'àlep és ineficient perquè no aprofita pràcticament res de la força que provoca l'aigua. 

 

 

6.4.- Comparació amb la turbina de camp actual 

 

Per a poder fer-nos una idea de la diferència entre la turbina amb àleps normals i la turbina amb 

àleps modificats, s'han creat una sèrie de taules i gràfics comparatius. També es compararan imatges 

per a entendre els resultats numèrics. 

 

Primerament, mirarem les forces que pateix la turbina en cada cas. La principal diferència entre 

ambdós taules, és la component Z. A la turbina amb àleps modificats no s'experimenta una càrrega 

vertical tant elevada, per tant, tot el sistema de rodaments inferiors de la turbina patirà molt menys. 

Les altres components augmenten una mica en la turbina amb àleps modificats, aspecte que 

interessa. 

 

A les figures 39 i 40 es poden veure els resultats mostrats a les taules 5 i 8 gràficament. 
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Figura 39. Comparació forces X entre la turbina tradicional i la turbina modificada 

 

 

Figura 40. Comparació forces Y i Z entre la turbina tradicional i la turbina modificada 

 

A la Figura 39 s'observa que la component de la força que genera parell rotatiu efectiu a la turbina 

amb àleps modificats és un 30% major que la de la turbina tradicional. En el gràfic de la Figura 40 es 

pot veure que la força Z s'ha disminuït un 300% a la zona de major rendiment (150 revolucions per 

minut). A les mateixes revolucions, la força Y ha disminuït en menor percentatge, un 140%, però tot i 

així és significatiu. Amb els resultats numèrics i gràfics, es comprova que si l'àlep està ben dissenyat, 

la sol·licitació de forces a l'àlep és menor. 
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A les taules 6 i 9 hi han les dades corresponents als moments mitjos per la turbina amb àleps normals 

i la d'àleps modificats. A les figures 41 i 42 es representen els resultats de les taules 6 i 9. 

 

 

Figura 41. Comparació parell mitjà Z entre la turbina tradicional i la turbina amb àleps modificats 

 

 

Figura 42. Comparació entre els parells X i Y de la turbina tradicional i la turbina amb àleps modificats 
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Observant les taules 6 i 9 i les figures 41 i 42, és comprova que la reducció dels parells no desitjables 

és molt significativa. En el cas del parell X, s'ha reduït una mitjana d'un 225%, i en el cas del parell Y, 

s'ha reduït una mitjana de 450%. A més, es pot apreciar que les corbes de parell X i Y tradicionals, 

segueixen unes trajectòries completament irregulars. Això és degut al mal disseny de l'àlep 

tradicional, i pot ser que degut al gruix de l'àlep i la poca separació entre ells provoqui que l'aigua 

impacti a la part posterior de l'àlep, generant aquestes irregularitats. En canvi, les corbes de parell X i 

Y de la turbina amb àleps modificats, presenten unes tendències regulars i previsibles. 

 

A la Figura 43 es pot veure la comparació entre la corba característica de la turbina tradicional i la 

turbina amb àleps modificats. Al gràfic, s'observa que la corba característica de la turbina tradicional 

és més planera que la de la turbina amb àleps modificats. Això fa que la turbina amb àleps modificats 

només sigui apropiada per un règim molt determinat de revolucions (a prop les 150 revolucions per 

minut), i per els altres règims de revolucions no sigui recomanable. 

 

 

 

Figura 43. Comparació potències turbina tradicional i turbina amb àleps modificats 

 

La Figura 44 compara la distribució de forces de la turbina amb àleps normals i la turbina amb àleps 

modificats. La diferència de distribució de forces és plausible a simple vista. 
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Figura 44. Comparació de la distribució de forces X a 150 rpm. a) àleps normals  b) àleps modificats 

 

 

Tot i que al cas de la turbina amb àleps normals la distribució de forces és molt bona, es pot 

comprovar que la distribució amb els àleps modificats és molt millor. Aquesta millor distribució 

permet generar un parell Z major, i així augmentar la potència i rendiment. 

 

La Figura 45 compara la trajectòria de les línies de corrent entre la turbina amb àleps modificats i la 

turbina amb àleps convencionals. Es pot veure que a la turbina amb àleps convencionals les línies de 

corrent es divideixen equitativament entre la part superior i la inferior de l'àlep.  En canvi a la turbina 

amb àleps modificats, tot el flux d'aigua es dirigeix cap a la part inferior. Els àleps modificats recullen 

tot el doll d'aigua, mentre que a la turbina amb àleps convencionals una part de l'aigua es pot 

escapar cap endavant. 

 

 

 

 

A 

A B 
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Figura 45. Línies de corrent del doll d'aigua a 150 rpm. a) àleps convencionals b) àleps modificats 
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CAPÍTOL 7. CONCLUSIONS 
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Després d'analitzar i estudiar tots els resultats obtinguts de totes les simulacions, es poden extreure 

les següents conclusions: 

 

 - La influència en el tipus de mallat dels elements determina la validesa de la solució, però en 

 el cas específic de simulació de turbines picohidràuliques la variació per número d'elements 

 és molt feble, ja que entre dues malles, l'una amb el doble d'elements que l'altra, els 

 resultats varien de l'ordre d'un 3%. 

 

 - S'ha utilitzat la dinàmica de fluids computacional per obtenir les corbes característiques de 

 les turbines. Aquestes simulacions són molt complexes ja que corresponen a un flux 

 transitori, bifàsic (aire i aigua) i amb elements mòbils (rodet). Per això, una simulació que 

 inclogui uns 6 períodes (o passos d'àleps davant del flux d'aigua incident) triga entre 4 i 5 

 dies. 

 

 - El nou disseny de l'àlep és més eficient gràcies a que la seva morfologia aconsegueix 

 aprofitar més bé les components de força del doll d'aigua per a la rotació de la turbina. A 

 més, a la vegada es redueixen els parells que no interessen per a l'aplicació d'aquestes 

 turbines. Així es reduirà els esforços induïts a l'estructura de suport de la turbina, reduint 

 la ruptura i manteniment d'aquests elements. 

 

 - Els nous àleps confereixen una nova corba de potència a la turbina. Aquesta nova corba és 

 molt més punxeguda, amb un màxim de potència a 150 revolucions per minut , que provoca 

 que la turbina sigui menys elàstica alhora de treballar (pugui treballar a menys règims de 

 revolucions eficientment). I per tant, el seu ús queda molt limitat a certs casos concrets. 

 Probablement, un augment del nombre d'àleps de la turbina modificada augmentaria la 

 potència obtinguda, i més important, produiria una corba de potència més planera i 

 aprofitable. A més, degut al poc gruix dels àleps, la introducció de més àleps no comportaria 

 un excessiu problema d'impactes d'aigua en la part posterior dels àleps. 

 

 - Aquesta nova corba de potència, en el nostre cas, és favorable, ja que la població 

 himàlaienca, ha establert que el millor règim de gir és a 150 revolucions per minut, perquè 

 sinó la matèria que molen queda malmesa i no és apte per a el consum. 
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 - Aquesta modificació només és beneficiosa en el cas que es treballi a 150 revolucions per 

 minut. Si es volgués treballar a altres règims de gir, en la majoria de casos, la turbina amb 

 àleps normals possiblement seria més adequada. 

 

 - Durant el projecte s'ha observat que els programes Ansys Workbench 13.0  i STAR-CCM+ en 

 el cas de turbines picohidràuliques a règims baixos de revolucions no s'acaben d'ajustar gaire 

 bé a la realitat, ja que els resultats obtinguts de les seves simulacions i els valors reals de 

 camp només s'ajusten a uns règims molt concrets de revolucions. Als altres règims de 

 revolucions les solucions obtingudes han estat errònies. 

  

 - El programa Ansys Workbench 13.0 s'ajusta més a les dades reals de camp en turbines 

 picohidràuliques a baixes revolucions que el programa STAR-CCM+, tot i que la variació entre 

 els programes, així com amb la realitat, és de l'ordre d'un 5%. 

 

 - El bloc FLUENT de l'Ansys Workbench no permet calcular quan tenim malles de més de 

 512.000 elements, en canvi el CFX no dóna problemes en aquest aspecte. 

 

 - El CFX dóna problemes alhora de calcular si s'escull la opció "règim turbulent". Degut a 

 això, pot ser que els resultats difereixin de la realitat. 

 

 

Signat: 

 

 

David Canals Camps 

Girona, 24 de maig del 2013 
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La relació de documents que formen aquest projecte és la següent: 

 

 1.- MEMÒRIA I ANNEXOS 

  Annex A. Turbines hidràuliques 

  Annex B. Geometries 

  Annex C. Mallat amb Ansys Workbench 

  Annex D. Setup de la simulació amb CFX 

  Annex E. Setup de la simulació amb STAR CCM+ 

  Annex F. Obtenció de resultats 

   

 2.- PRESSUPOST 

  Annex al pressupost 
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HIDRÀULIQUES 
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A1.- Antecedents 

 

No es sap amb exactitud qui va ser el primer que va aprofitar  la força i energia de l'aigua, però el que 

sí es pot intuir és que l'idea de la seva utilització recau en una necessitat més antiga, el reg. Per al 

reg, s'utilitzaven diferents mètodes per elevar l'aigua del riu a una alçada major que la dels seus 

marges per tal de fer-la córrer per canals. Els mecanisme utilitzat era la roda persa o saqia, que 

consistia en una gran roda amb culleres a la seva perifèria, muntada en un eix horitzontal. En aquest 

eix horitzontal, a través d'engranatges i un braç  s'hi lligava bestiar per fer-la girar i així facilitar 

l'ascensió de l'aigua. Hom va veure la possible utilització de la força de l'aigua quan deslligaven el 

bestiar del braç, i la roda girava en sentit contrari degut a la corrent del riu. La primera aplicació 

bàsica de les rodes hidràuliques  va ser la mòlta de gra. 

 

En la Figura A1, es poden veure els diferents dissenys de les primeres rodes hidràuliques utilitzades. 

 

 

Figura A1. Primeres rodes hidràuliques, precedents de les turbines hidràuliques. a) alimentació superior b) alimentació 

lateral c) de paletes planes d) d'impulsió inferior e) paletes d'alimentació inferior f) turbina Banki.  

MATAIX, C., Turbomáquinas Hidraúlicas, Editorial ICAI, 1974 
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L'ús de les turbines es va començar a extendre a partir del segle VII a Anglaterra, i d'ençà, diferents 

científics van començar a estudiar-les matemàticament. Entre els diferents científics, cal destacar els 

treballs realitzats per Leonardo Da Vinci, Galileo, Descartes, Euler i el fràncès Parent, que va preveure 

que hi ha una relació òptima entre la velocitat de la roda i la velocitat de la corrent d'aigua que 

l'impulsa. A la Figura A2 es pot veure un dels primer dissenys de turbina, proposada per Euler. 

 

 

Figura A2. Turbina proposada per Euler. 

 MATAIX, C., Turbomáquinas Hidraúlicas, Editorial ICAI, 1974 

 

A grans trets, es podria esquematitzar l'evolució de les turbines com: 

 

 - Segle XVIII és el segle de la seva gestació. 

  

 - Segle XIX és el segle del seu naixement i aplicació. A Amèrica neixen les turbines   

 Francis i Pelton. 

  

 -  Segle XX és el segle del seu desenvolupament. 

   

  1915- Turbina Kaplan 

  1918- Turbina Banki 

  1914- Turbina Turgo 

  1950- Turbina Deriaz 

  1970- Turbina Bulbo 
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Les figures A3, A4, A5, A6, A7, A8 i A9 mostren les diferents morfologies de turbina. 

 

 

Figura A3. Rodet de turbina Francis  

(http://es.wikipedia.org/wiki/Turbina_Francis) 

 

 

Figura A4. Rodet de Turbina Pelton  

(http://es.wikipedia.org/wiki/Turbina_Pelton) 
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Figura A5.Rodet de turbina Kaplan  

(http://www.endesaeduca.com/Endesa_educa/recursos-interactivos/produccion-de-electricidad/xi.-las-centrales-hidroelectricas) 

 

 

 

Figura A6.Rodet d'una petita turbina Banki  

(http://www.grenergia.com.ar/productos.html) 
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Figura A7. Croquis d'instal·lació d'una turbina Turgo 

( http://es.wikipedia.org/wiki/Turbina_Turgo) 

 

 

Figura A8. Rodet de turbina Deriaz.  

(http://www.directindustry.es) 
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Figura A9. Esquema d'una instal·lació d'una turbina Bulbo subaquàtica 

http://spanish.hydrotu.com/china-100kw_10mw_high_efficiency_bulb_hydro_turbine_for_head_2m_20m-293774.html 

 

 

A2.- Característiques de les turbines picohidràuliques 

 

Una turbina picohidràulica és un tipus de turbina hidràulica. Una turbina hidràulica és una 

turbomàquina motora hidràulica que aprofita l'energia d'un fluid que circula a través d'ella per tal de 

produir un moviment de rotació, que a través d'un eix mou directament una màquina o un generador 

que transforma l'energia mecànica en elèctrica. 

 

Una turbina picohidràulica, tal i com indica el seu propi nom, és una turbina, d'un tamany molt 

reduït, respecte el tamany que s'entén com a estàndard. El tamany d'una turbina estàndard, es pot 

estimar a les dimensions que té una turbina d'una central hidroelèctrica (la cota del diàmetre 

exterior està compresa entre 7 i 10 metres aproximadament). 

 

Per tant, el que es defineix com a turbina picohidràulica és una turbina de tamany "domèstic" (la cota 

del diàmetre exterior està compresa entre 20 i 50 centímetres). A la figura A10 es pot veure la 

diferència de tamany entre una turbina picohidràulica i una turbina hidràulica convencional. 
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Figura A10. Comparació de tamany entre turbina picohidràulica i turbina hidràulica. 

a) Turbina picohidràulica artesanal   b) rotor d'una turbina Francis 

(a) http://rotondaro.com.uy/blog/es/node/25 b) http://es.wikipedia.org/wiki/Turbina_Francis) 

 

 

A2.1.- Avantatges i inconvenients de les turbines picohidràuliques 

 

Abans de fer qualsevol tipus d'estudi, cal saber quins són els avantatges i inconvenients de les 

turbines picohidràuliques, per saber els punts forts i els febles d'aquestes. 

 

Avantatges: 

  

 - Molt econòmiques respecte a les turbines convencionals. 

 - Fàcil disseny i construcció. 

 - Fàcil funcionament i manteniment baix i senzill. 

 - Es poden instal·lar a qualsevol rierol sempre que aquest tingui un cabal mínim. 

 - Poden treballar a diferents règims de revolucions i amb diferents cabals. 

 - Fàcil modificació i gran adaptabilitat a les necessitats específiques de cada cas en 

 concret. 
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Inconvenients: 

 

 - Baixos rendiments degut a diferents factors que s'estudiaran en el present projecte. 

 - Baixa tecnificació i desenvolupament. 

 - L'energia obtinguda és molt petita, i per tant l'ús de les turbines picohidràuliques queda 

 molt limitat a certs usos. 

 - En el cas particular que s'estudiarà de les turbines instal·lades a l'Himàlaia, al ser 

 fabricades amb fusta, i amb tècniques rudimentàries, pateixen ruptures i precisen de  més 

 manteniment que una turbina fabricada amb plàstic o acer inoxidable.  
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ANNEX B. GEOMETRIES 
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B1 .- Generació de les geometries amb Autodesk Inventor 2012 

 

Per a realitzar les geometries amb CAD, primer s'han tingut de prendre les mides a les diferents 

turbines a estudiar i llavors representar-les informàticament amb Autodesk Inventor 2012. 

Mitjançant aquest software s'han realitzat 3 cossos diferents: el rodet de la turbina, el doll d'aigua, i 

el canal d'aigua. A la part esquerra de  les figures B1, B2 i B3 es pot veure el procés seguit per a la 

representació de la turbina del laboratori de fluidomecànica, la turbina picohidràulica de l'Himalàia i 

la proposta de turbina amb àleps millorats, respectivament. 

 

 

 

Figura B1 . Procès seguit per a representar la turbina del laboratori de fluidomecànica. A la figura es pot veure que el doll 

d'aigua i el canal són dos cossos diferents, encara que estiguin units (negre i groc, respectivament) 
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Figura B2 . Procès seguit per a representar la turbina picohidràulica de l'Himàlaia  

 

 

 

Figura B3 . Procès seguit per a representar la proposta de millora de la turbina de l'Himàlaia 

 

 



 

Millora del rendiment hidràulic d'una turbina picohidràulica Memòria i annexos 

80 
 

 

Un cop representades les geometries, s'han de guardar, i obrir els arxius amb una extensió de 

l'Audodesk Inventor 2012, anomenada Inventor Fusion 2012. Aquest programa el que permet és 

obrir els arxius en format ".IPT" (extensió dels arxius que genera l'Autodesk Inventor), i guardar-los 

amb un altre format, per exemple ".SAT", o ".IGS". Els arxius en format ".SAT" o ".IGS" són arxius amb 

format "neutre" per assegurar la compatibilitat entre diferents programes. Aquesta transformació 

d'extensió és necessària perquè el format ".IPT" no és compatible amb el bloc de disseny de l'Ansys 

Workbench, i en canvi el ".SAT" o l' ".IGS" si.  

 

En el present cas s'ha optat per transformar-los al format ".SAT", perquè transformant-los a ".IGS", es 

va observar que hi havia una lleugera distorsió de les mides de les turbines, i en el format ".SAT" 

aquesta deformació no s'hi experimentava. 

 

B2.- Creació d'un nou projecte amb Ansys Workbench 

 

Per a poder començar a treballar amb el software Ansys Workbench, s'ha de llançar l'aplicació clicant 

dues vegades sobre la icona Workbench que es troba en l'escriptori dels ordinadors de l'aula CFD de 

l'àrea de Mecànica de Fluids de la Universitat de Girona. Un cop s'obri el programa, a la pantalla del 

nostre ordinador apareixerà l'interfície de treball del Workbench, tal i com mostra la figura B4. 

 

 

Figura B4. Interfície de treball de l'Ansys Workbench 
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Com es pot veure a la figura B4, l'Ansys Workbench ofereix moltes opcions per a treballar (Toolbox, 

part esquerra de la imatge), però a nosaltres la que ens interessa és la de Fluid Flow (CFX). Cliquem 

dues vegades sobre Fluid Flow (CFX), i a la pantalla principal Project Schematic, ens apareixerà un 

bloc com el mostrat a la figura A5. 

 

 

Figura B5. Bloc CFX de l'Ansys Workbench 

 

Llavors, s'haurà d'anar clicant a la opció Geometry, Mesh, Setup, Solution o Results depenent del pas 

en què ens trobem de la simulació. És evident que són passos consecutius, i per tant, haurem de 

respectar l'ordre en què estan per anar avançant amb el nostre projecte. 

 

 

B3.- Generació dels volums de control amb el Design Modeller (extensió de l'Ansys 

Workbench) 

 

Per definir els volums de control, s'utilitzarà el Design Modeller. Primerament, tenim 3 cossos 

diferents, que són els provinents de la representació amb Autodesk Inventor. Els volums que 

inicialment tenim són: 

  

 - Volum 1: Rodet de la turbina 

 -Volum 2: Doll d'aigua 

 - Volum 3: Canal d'alimentació de l'aigua (canonada o mànega)  
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A aquests cossos els hi hem d'afegir els dos cilindres que s'utilitzaran com a volums de control (el que 

engloba tot l'experiment, i el que engloba només la turbina). Aquests cilindres han de tenir unes 

dimensions adequades perquè la simulació sigui vàlida. El cilindre que engloba el rodet (d'ara 

endavant serà anomenat com a "cilindre petit") ha de tenir unes dimensions molt similars a les del 

rodet en qüestió. El cilindre que engloba el conjunt global (d'ara endavant serà anomenat com a 

"cilindre gros"), ha de tenir un diàmetre aproximadament del doble del rodet perquè sigui 

suficientment gran com per cobrir qualsevol gota o flux d'aigua que tingui una trajectòria 

desconeguda, sense afectar a la simulació. S'ha escollit aquesta relació entre diàmetre del volum de 

control gran i rodet, perquè es tenen dades d'un projecte similar, anterior al present, on es va 

comprovar que aquesta era la relació idònia. En el projecte, es va establir que la mida mínima per no 

afectar a la simulació era aproximadament del doble del diàmetre del rodet, sense incrementar 

excessivament el nombre d'elements de la malla, i allargar molt el càlcul. Per conseqüent, cada cas 

(turbina laboratori i turbina tradicional Himàlaia) tindrà uns cilindres diferents. 

 

Creant els  volums de control, hi ha una pestanya anomenada Operation que ens permet escollir el 

tipus de textura que volem que tingui el nou volum. En aquesta pestanya hem d'escollir Add Frozen. 

Aquesta opció crea arxius de volum sense afegir-los al volum existent, i és el que interessa, perquè si 

li poséssim Add material el que faria seria afegir material a sobre dels volums anteriors, i el resultant 

seria un sol volum fusionat amb els antics, i no hi podríem treballar.   

 

Mides cilindres de control de la turbina del laboratori de fluidomecànica:  

 

 - Cilindre petit:   

  - Radi: 185 mm 

  - Alçada: 30 mm 

  - Centrat respecte el rodet 

 

 - Cilindre gros: 

  - Radi:  360 mm 

  - Alçada: 250 mm 

  - Descentrat 150 mm en direcció negativa en l'eix de les Z respecte el centre del 

      rodet. 
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El cilindre gros s'ha de descentrar cap avall perquè ens interessa controlar quina trajectòria segueix 

el flux de l'aigua que ja s'ha utilitzat per donar parell a la turbina. La part superior no té tant d'interès, 

perquè sabem que l'aigua va per dins de la mànega. En la figura A6 es pot apreciar el rodet amb el 

seu volum de control, i el volum de control gros descentrat 150 mm cap avall. 

 

 

Figura B6. Representació dels volums de control de la turbina del laboratori de fluidomecanica de la UdG. 

 

Mides cilindres de control de la turbina real de l'Himàlaia:  

 

 - Cilindre petit:   

  - Radi: 470 mm 

  - Alçada: 135 mm 

  - Centrat respecte el rodet 

 

 - Cilindre gros: 

  - Radi:  940 mm 

  - Alçada: 1100 mm 

  - Descentrat 450 mm en direcció negativa en l'eix de les Z respecte el centre del 

      rodet. 

 

Les mides dels volums de control de la turbina amb àleps modificats són les mateixes que les de la 

turbina real de l'Himàlaia, perquè s'han mantingut les mateixes mides de la turbina, i per tant, les 

dels cilindres de control. 
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Com a consequència, després de fer els dos cilindres corresponents, es tenen 5 cossos. Per a fer la 

simulació, ens interessa fusionar-los fins a tenir només 3 cossos. Per aconseguir passar de 5 cossos a 

3, el Design Modeller té una eina anomenada Boolean que ens permet fer operacions entre cossos.  

A la figura A7 podem veure els 5 volums diferents abans de fer les operacions booleanes. 

 

 

Figura B7. Volums abans de fer les operacions booleanes 

 

Els volums que desitgem tenir són: 

 

 - Volum 1: Rodet de la turbina 

 -Volum 2: Volum de control que engloba a tot l'experiment 

 -Volum 3: Trajectòria del doll d'aigua 

 

A cada volum final se li atorgaran unes característiques específiques segons la seva naturalesa (Annex 

C). 

 

La operació booleana que ens interessa utilitzar és la de la resta. Per fer els booleans s'anirà a Create 

→ Boolean.  Llavors apareix un bloc amb diferents pestanyes on hem d'indicar si volem fer 

operacions de suma o resta, en aquest cas resta. A més, li hem d'indicar amb quins volums volem 

operar, i si volem mantenir els volums un cop feta la operació (Preserve Tool Bodies → Yes/No). 

Depenent de la operació, ens interessarà mantenir, o no els cossos primitius, tal i com s'indica a 

continuació. El procés que s'ha seguit per fer les operacions entre cossos ha estat: 

 

    Mànega 

  Doll d'aigua 

Cilindre petit 

    Turbina 

  Cilindre gros 
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 1r booleà: Cilindre gros - mànega. Sense mantenir els volums inicials. 

 2n booleà: El volum resultant del primer booleà - doll d'aigua. Mantenint els volums. 

 3r booleà: Volum resultant del 2n booleà - cilindre petit. Mantenint els volums. 

 4t booleà: Cilindre petit -  rodet. Sense mantenir els volums. 

 

A la figura B8 es pot veure els cossos resultants de les operacions booleanes. Tot i que les figures B7 i 

B8 es poden assemblar, val a dir que les característiques de cada situació són completament 

diferents. A la figura B8, el que tenim són els 3 volums finals, consistents d'aire, aigua i sòlid 

depenent de quin volum sigui (Annex D). 

 

 

 

Figura B6. Volums finals, preparats per a ser mallats. 
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ANNEX C. MALLAT AMB ANSYS 

 WORKBENCH 
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C1.- Introducció al mallat 

 

Un cop definits els diferents volums, ja es pot procedir a mallar els volums amb el bloc de mallat de 

l'Ansys Workbench. El mallat no és més que la divisió d'un volum en molts de més petits, relacionats 

entre ells. Això permet organitzar el volum per facilitar el càlcul de la computadora . 

 

El nombre de cel·les creades influeix en el temps de càlcul de la simulació, de manera que un mallat 

de molts elements serà més lent que un de pocs elements. És per això que a les zones més rellevants 

dels volums s'ha de realitzar un mallat més fi, i per altra banda, a les regions menys importants es pot 

crear un mallat més bast. S'ha d'aconseguir que la mida de les cel·les sigui suficient com per 

representar correctament el flux, i així obtenir un equilibri entre una bona malla i una velocitat de 

simulació raonable. 

 

Les regions més rellevants de la nostra geometria són els àleps del rodet, la zona de contacte entre el 

volum de control gros, i el volum de control petit, i el doll d'aigua. Així doncs, s'haurà de tenir una 

densitat de malla més elevada en aquestes regions. Això es farà mitjançant l'eina Face Sizing, la qual 

permet començar a mallar més fi a la zona desitjada, i anar augmentant el tamany de les cel·les a 

mida que anem allunyant-nos d'aquella zona. En la Figura C1 es pot comprovar la diferència de 

tamany de cel·les entre les zones més rellevants per a l'estudi, i les menys. 

 

 

Figura C1. Secció del volum de control gran per la part on està en contacte amb el volum de control petit 
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C2.-  Procediment seguit per a mallar la turbina del laboratori de fluidomecànica de la UdG 

 

Per a mallar els 3 volums diferents, s'ha d'anar un per un. El subprograma de l'Ansys encarregat de 

mallar els volums és capaç de mallar tots 3 cossos alhora, però quedaria una malla  amb un tamany 

de cel·les uniforme per els tres elements, qüestió que no interessa. Com que cada cos és diferent i té 

diferents rellevàncies alhora de calcular, s'hauran de mallar cada un per separat. 

 

Per mallar cada volum independent dels altres, s'hauran de suprimir tots els elements que no 

estiguem mallant. Per suprimir un element, s'ha d'anar a la banda esquerra de la pantalla del bloc 

Meshing de l'Ansys Workbench, clicar sobre Geometry, on veurem que hi ha les 3 geometries que 

s'han de mallar, tal com mostra la figura C2, i clicar amb el botò dret del ratolí sobre l'element que 

vulguem suprimir i seleccionar Supress Body. D'aquesta manera, totes les configuracions que 

imposem en un element no es veuran afectades per les configuracions dels altres.  

 

 

Figura C2. Estructura del bloc de mallat de l'Ansys Workbench 

 

Com es pot comprovar a la Figura C2, els elements que estan suprimits en aquest moment, tenen al 

seu davant una creu blava (X), i els que no estan suprimits, tenen un tic verd (√ ). 
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C2.1.- Mallat del doll d'aigua 

 

El doll d'aigua és l'element més petit, i alhora un dels més importants. Així, haurem de prestar 

especial atenció alhora de mallar-lo. Tal i com s'ha comentat anteriorment, s'han de suprimir tots els 

elements menys el doll d'aigua. Un cop tinguem només el doll d'aigua activat, haurem d'anar a la 

pestanya Mesh de l'arbre que hi ha al costat esquerre de la pantalla de la plataforma de mallar. A 

sobre la pestanya Mesh, farem clic amb el botó dret del ratolí i li indicarem que volem afegir un nou 

Face Sizing (Insert → Sizing ) que correspondrà al doll d'aigua. 

 

Acte seguit ens apareixerà el bloc mostrat a la Figura C3, a la banda inferior esquerra de la pantalla: 

 

 

Figura C3. Configuració del Face Sizing  del doll d'aigua 

 

Cliquem a la pestanya Geometry, i haurem d'anar a la pantalla principal, on està el doll d'aigua 

representat, i en aquest cas, seleccionar totes les cares de la geometria. En el doll d'aigua s'ha de 

seleccionar tot, perquè és un dels elements més importants, i la malla ha de ser molt fina i regular. 

Dins de la pestanya Element Size, haurem de definir el tamany dels elements que conformaran la 

malla. La resta d'opcions per defecte, per al nostre cas, ens van bé. 
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Tamany de les cel·les del Face Sizing "Aigua": 

 

 - Turbina laboratori fluidomecànica UdG: 1 mil·límetre. 

 - Turbina real Himàlaia : 6 mil·límetres. 

 - Turbina real àleps modificats: 6 mil·límetres. 

 

Cada vegada que fem un Face Sizing, apareix una branca que depèn del pare Mesh. Si cliquem a 

sobre el Face Sizing amb el botó dret, i escollim l'opció Rename, li podrem posar el nom que 

convingui per tal de poder-los identificar millor. 

 

Un cop creat el Face Sizing, cliquem a sobre Mesh, i ens apareixerà un quadre amb diverses opcions 

alhora de mallar, com el que mostra la figura C4. En aquest quadre ens centrarem en l'apartat Sizing. 

 

 

Figura C4. Configuració del Mesh del doll d'aigua 

 



 

Millora del rendiment hidràulic d'una turbina picohidràulica Memòria i annexos 

91 
 

 

A la pestanya Use Advanced Size Function escollirem On: Curvature. S'escull aquesta opció perquè 

després de fer diverses proves, s'ha estipulat que és la que més s'adequa al nostre cas particular. 

Aquesta opció el que fa és mallar de la manera que la malla s'adapti més al radi de curvatura dels 

elements. Al ser tot elements rodons, és obvi que és la millor opció a escollir. Les altres opcions 

s'adeqüen més a altres tipus de geometries, tals com geometries amb moltes arestes, entre d'altres. 

 

Les següents pestanyes quedaran de la següent manera: 

  

 - Relevance Center: Fine 

 - Initial Size Seed: Active Assembly 

 - Smoothing: High 

 - Transition: Slow 

 - Span Angle Centre: Fine 

 - Curvature Normal Angle: Default 

 - Min Size: la definirem en funció de cada cas específic 

 - Max Face Size: la definirem en funció de cada cas específic 

 - Max Size: la definirem en funció de cada cas específic 

 - Growth rate: 1'20. 

 - Minimum Edge Length: Default 

 

De la resta d'opcions que ens permet el software mallador, els paràmetres que dóna per defecte ens 

són vàlids per el nostre cas. 

 

Mides mínimes i màximes de les cares i cel·les del mallat "Doll d'aigua": 

 

 - Turbina laboratori fluidomecànica UdG:  

  - Min Size: 1 mil·límetre 

  - Max Face Size: 2 mil·límetres 

  - Max Size:  2 mil·límetres 

 

 - Turbina real Himàlaia: 

  Min Size: 6 mil·límetre 

  - Max Face Size: 6 mil·límetres 

  - Max Size:  10 mil·límetres 
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 - Turbina real àleps modificats: 

  - Min Size: 6 mil·límetre 

  - Max Face Size: 10 mil·límetres 

  - Max Size:  10 mil·límetres 

 

Un cop establerts els diferents paràmetres en què volem basar el nostre mallat, clicarem amb el botó 

dret sobre Mesh → Generate Mesh. La computadora calcularà el mallat, i el representarà a la 

pantalla principal, tal i com mostra la Figura C5. En el cas del doll d'aigua, podem veure que és un 

mallat molt fi i uniforme, degut a la seva importància. 

 

 

Figura C5. Mallat del doll d'aigua de la turbina del laboratori de fluidomecànica de la UdG. 

 

Si ens interessés saber el número d'elements i nodes que té l'element que acabem de mallar, podem 

clicar sobre Mesh i dins del menú que ens apareix desplegar la pestanya de Statistics, i allà hi haurà 

indicats tant el número de nodes com el número d'elements del volum mallat. 

 

Un cop mallat el doll d'aigua, per seguir mallant la resta d'elements, haurem de clicar sobre 

Geometry i clicar amb el botó dret sobre Doll d'aigua → Supress Body. Com que teniem la resta de 

cossos suprimits, la pantalla principal ens quedarà buida. Ara haurem de clicar amb el botó dret 

sobre el cos que vulguem "des-suprimir" i començar tot el procés de mallat de nou amb el nou 

volum. 
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C2.2.- Mallat de la turbina 

 

La turbina és l'element objecte d'estudi, i per tant el més important. Així, haurem de prestar especial 

atenció alhora de mallar-la. Tal i com s'ha comentat anteriorment, s'han de suprimir tots els 

elements menys la turbina. Un cop tinguem només la turbina activada, haurem d'anar a la pestanya 

Mesh de l'arbre que hi ha al costat esquerre de la pantalla de la plataforma de mallar. A sobre la 

pestanya Mesh, farem clic amb el botó dret del ratolí i li indicarem que volem afegir un nou Face 

Sizing (Insert → Sizing) que correspondrà a el rodet de la turbina. 

 

Acte seguit ens apareixerà el bloc mostrat a la Figura C6, a la banda inferior esquerra de la pantalla: 

 

 

Figura C6. Configuració del Face Sizing de la turbina 

 

Abans de seleccionar la geometria, s'ha de fer un pas previ per seleccionar correctament els 

elements als que ens interessa fer el Face Sizing. A la pantalla principal on tenim representat el 

volum de control que conté la turbina, hem de seleccionar la tapa superior amb el ratolí, clicar amb 

el botó dret i posar Hide Face(s).  Haurem de repetir el mateix procediment amb la tapa inferior del 

volum de control, i la superfície lateral. D'aquesta manera, només ens quedarà la turbina 

representada, sense les tapes del volum de control. Les figures B7 i B8 mostren el volum de control 

amb les tapes visibles, i amb les tapes desactivades, respectivament. 
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Figura C7. Volum de control amb les tapes visibles 

 

 

Figura C8. Volum de control amb les tapes desactivades 

 

 

En aquest cas, el que ens interessa és fer el Face Sizing a la turbina sencera, però a les tapes del 

volum de control no, perquè no tenen tanta rellevància en el càlcul, i quan menys elements tingui la 

malla, més ràpid anirà alhora de calcular.  

 

Cliquem a la pestanya Geometry, i haurem d'anar a la pantalla principal, on està la turbina 

representada (Figura B8), i en aquest cas, seleccionar tots els elements de la geometria. Per tal de 

seleccionar-los tots alhora, al quadre de comandes de la part superior de la pantalla clicarem sobre 

l'icone Select Mode i escollirem Box Select. Així podrem fer una selecció múltiple fent un requadre 

que inclogui a tota la turbina.  
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A la pestanya Geometry de la Figura C6, ens apareixerà 247 Faces pel cas de la turbina del laboratori 

de fluidomecanica de la Universitat de Girona. Dins de la pestanya Element Size, haurem de definir el 

tamany dels elements que conformaran la malla. La resta d'opcions per defecte, per al nostre cas, 

ens van bé. 

 

Tamany de les cel·les del Face Sizing "Turbina": 

 

 - Turbina laboratori fluidomecànica UdG: 2 mil·límetres. 

 - Turbina real Himàlaia : 7 mil·límetres. 

 - Turbina real àleps modificats: 7 mil·límetres. 

 

Cada vegada que fem un Face Sizing, apareix una branca que depèn del pare Mesh. Si cliquem a 

sobre el Face Sizing amb el botó dret, i escollim l'opció Rename, li podrem posar el nom que 

convingui per tal de poder-los identificar millor. 

 

Un cop creat el Face Sizing, cliquem a sobre Mesh, i ens apareixerà un quadre amb diverses opcions 

alhora de mallar, com el que mostra la Figura C9. En aquest quadre ens centrarem en l'apartat Sizing. 

 

 

Figura C9. Configuració del Mesh 
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A la pestanya Use Advanced Size Function escollirem On: Curvature. S'escull aquesta opció perquè 

després de fer diverses proves, s'ha estipulat que és la que més s'adequa al nostre cas particular. 

Aquesta opció el que fa és mallar de la manera que la malla s'adapti més al radi de curvatura dels 

elements. Al ser tot elements rodons, és obvi que és la millor opció a escollir. Les altres opcions 

s'adeqüen més a altres tipus de geometries, tals com geometries amb moltes arestes vives, entre 

d'altres. 

 

Les següents pestanyes quedaran de la següent manera: 

  

 - Relevance Center: Fine 

 - Initial Size Seed: Active Assembly 

 - Smoothing: High 

 - Transition: Slow 

 - Span Angle Centre: Fine 

 - Curvature Normal Angle: Default 

 - Min Size: la definirem en funció de cada cas específic 

 - Max Face Size: la definirem en funció de cada cas específic 

 - Max Size: la definirem en funció de cada cas específic 

 - Growth rate: 1'20. 

 - Minimum Edge Length: Default 

 

De la resta d'opcions que ens permet el software mallador, els paràmetres que dóna per defecte ens 

són vàlids per el nostre cas. 

 

Mides mínimes i màximes de les cares i cel·les del mallat "Turbina": 

 

 - Turbina laboratori fluidomecànica UdG:  

  - Min Size: 2 mil·límetres 

  - Max Face Size: 4 mil·límetres 

  - Max Size:  4 mil·límetres 

 

 - Turbina real Himàlaia: 

  Min Size: 7 mil·límetres 

  - Max Face Size: 7 mil·límetres 
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  - Max Size:  10 mil·límetres 

 

 - Turbina real àleps modificats: 

  - Min Size: 7 mil·límetres 

  - Max Face Size: 10 mil·límetres 

  - Max Size:  10 mil·límetres 

 

Un cop establerts els diferents paràmetres en què volem basar el nostre mallat, clicarem amb el botó 

dret sobre Mesh → Generate Mesh. La computadora calcularà el mallat, i el representarà a la 

pantalla principal, tal i com mostra la Figura C10. En el cas de la turbina, podem veure que té una 

malla composta per un mallat molt fi allà on l'hi hem indicat el Face Sizing, i un mallat més bast a 

mida que ens allunyem de la zona amb el Face Sizing. 

 

 

Figura C10. Mallat de la turbina del laboratori de fluidomecànica de la UdG. 

 

Si ens interessés saber el número d'elements i nodes que té l'element que acabem de mallar, podem 

clicar sobre Mesh i dins del menú que ens apareix desplegar la pestanya de Statistics, i allà hi haurà 

indicats tant el número de nodes com el número d'elements del volum mallat. 
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Un cop mallada la turbina, per seguir mallant la resta d'elements, haurem de clicar sobre Geometry i 

clicar amb el botó dret sobre Turbina → Supress Body. Com que teniem la resta de cossos suprimits, 

la pantalla principal ens quedarà buida. Ara haurem de clicar amb el botó dret sobre el cos que 

vulguem "des-suprimir" i començar tot el procés de mallat de nou amb el nou volum. 

 

C2.3.- Mallat del volum de control gran 

 

El volum de control gran és el volum menys important de cares als càlculs, i per això el seu mallat 

serà de caire més bast. Tot i així, la zona de contacte entre el volum de control gran i el volum de 

control petit (o turbina) sí que és un punt crític, on la malla ha de ser suficientment fina com per no 

generar alteracions considerables en els resultats. Tal i com s'ha comentat anteriorment, s'han de 

suprimir tots els elements menys el volum de control gran. Un cop tinguem només el volum de 

control gran actiu, haurem d'anar a la pestanya Mesh de l'arbre que hi ha al costat esquerre de la 

pantalla de la plataforma de mallar. A sobre la pestanya Mesh, farem clic amb el botó dret del ratolí i 

li indicarem que volem afegir un nou Face Sizing (Insert → Sizing) que correspondrà a la zona de 

contacte entre ambdós volums de control. 

 

Acte seguit ens apareixerà el bloc mostrat a la Figura C11, a la banda inferior esquerra de la pantalla: 

 

 

Figura C11. Configuració del Face Sizing de la turbina 
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Abans de seleccionar la geometria, s'ha de fer un pas previ per seleccionar correctament els 

elements als que ens interessa fer el Face Sizing. A la pantalla principal on tenim representat el 

volum de control que conté la turbina, hem de seleccionar la tapa superior amb el ratolí, clicar amb 

el botó dret i posar Hide Face(s).  Haurem de repetir el mateix procediment amb la tapa inferior del 

volum de control, i la superfície lateral. D'aquesta manera, només ens quedarà la zona de contacte 

entre els dos volums de control, així com també el conducte d'entrada de l'aigua. Les figures C12 i 

C13 mostren el volum de control amb les tapes visibles, i amb les tapes desactivades, 

respectivament. 

 

 

Figura C12. Volum de control amb les tapes visibles 

 

 

Figura C13. Volum de control amb les tapes desactivades 
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En aquest cas, el que ens interessa és fer el Face Sizing a el que ha quedat representat a la pantalla 

principal, però a les tapes del volum de control no, perquè no tenen tanta rellevància en el càlcul, i 

quan menys elements tingui la malla, més ràpid anirà alhora de calcular.  

 

Cliquem a la pestanya Geometry, i haurem d'anar a la pantalla principal, on està el volum representat 

(Figura C13), i en aquest cas, seleccionar tots els elements de la geometria. Per tal de seleccionar-los 

tots alhora, al quadre de comandes de la part superior de la pantalla clicarem sobre l'icone Select 

Mode i escollirem Box Select. Així podrem fer una selecció múltiple fent un requadre que inclogui a 

tota el conjunt.  

 

A la pestanya Geometry de la Figura C11, ens apareixerà 5 Faces pel cas de la turbina del laboratori 

de fluidomecanica de la Universitat de Girona. Dins de la pestanya Element Size, haurem de definir el 

tamany dels elements que conformaran la malla. La resta d'opcions per defecte, per al nostre cas, 

ens van bé. 

 

Tamany de les cel·les del Face Sizing "Turbina": 

 

 - Turbina laboratori fluidomecànica UdG: 2 mil·límetres. 

 - Turbina real Himàlaia : 7 mil·límetres. 

 - Turbina real àleps modificats: 7 mil·límetres. 

 

Cada vegada que fem un Face Sizing, apareix una branca que depèn del pare Mesh. Si cliquem a 

sobre el Face Sizing amb el botó dret, i escollim l'opció Rename, li podrem posar el nom que 

convingui per tal de poder-los identificar millor. 

 

Un cop creat el Face Sizing, cliquem a sobre Mesh, i ens apareixerà un quadre amb diverses opcions 

alhora de mallar, com el que mostra la Figura C14. En aquest quadre ens centrarem en l'apartat 

Sizing. 
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Figura C14. Configuració del Mesh 

 

A la pestanya Use Advanced Size Function escollirem On: Curvature. S'escull aquesta opció perquè 

després de fer diverses proves, s'ha estipulat que és la que més s'adequa al nostre cas particular. 

Aquesta opció el que fa és mallar de la manera que la malla s'adapti més al radi de curvatura dels 

elements. Al ser tot elements rodons, és obvi que és la millor opció a escollir. Les altres opcions 

s'adeqüen més a altres tipus de geometries, tals com geometries amb moltes arestes vives, entre 

d'altres. 

 

Les següents pestanyes quedaran de la següent manera: 

  

 - Relevance Center: Fine 

 - Initial Size Seed: Active Assembly 

 - Smoothing: High 

 - Transition: Slow 

 - Span Angle Centre: Fine 

 - Curvature Normal Angle: Default 

 - Min Size: la definirem en funció de cada cas específic 

 - Max Face Size: la definirem en funció de cada cas específic 
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 - Max Size: la definirem en funció de cada cas específic 

 - Growth rate: 1'20. 

 - Minimum Edge Length: Default 

 

De la resta d'opcions que ens permet el software mallador, els paràmetres que dóna per defecte ens 

són vàlids per el nostre cas. 

 

Mides mínimes i màximes de les cares i cel·les del mallat "Turbina": 

 

 - Turbina laboratori fluidomecànica UdG:  

  - Min Size: 2 mil·límetres 

  - Max Face Size: 6 mil·límetres 

  - Max Size:  6 mil·límetres 

 

 - Turbina real Himàlaia: 

  Min Size: 7 mil·límetres 

  - Max Face Size: 30 mil·límetres 

  - Max Size:  30 mil·límetres 

 

 - Turbina real àleps modificats: 

  - Min Size: 7 mil·límetres 

  - Max Face Size: 30 mil·límetres 

  - Max Size:  30 mil·límetres 

 

Un cop establerts els diferents paràmetres en què volem basar el nostre mallat, clicarem amb el botó 

dret sobre Mesh → Generate Mesh. La computadora calcularà el mallat, i el representarà a la 

pantalla principal, tal i com mostren les Figura B15 i B16. En el cas del volum de control gran, veiem 

que és un mallat compost per una malla basta per la banda exterior del cilindre, i una malla fina per 

la banda interior del contacte, allà on hem indicat el Face Sizing.  
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Figura C15. Mallat del volum de control gran corresponent a la turbina del laboratori de fluidomecànica de la UdG. 

 

 

Figura C16. Secció del mallat del volum de control gran corresponent a la turbina del laboratori de fluidomecànica de la 

UdG. 

 

Si ens interessés saber el número d'elements i nodes que té l'element que acabem de mallar, podem 

clicar sobre Mesh i dins del menú que ens apareix desplegar la pestanya de Statistics, i allà hi haurà 

indicats tant el número de nodes com el número d'elements del volum mallat. 
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C3.- Named Selections 

 

Com a últim pas de l'etapa de mallat, hem de generar unes etiquetes en relació a una superfície. 

Aquestes etiquetes, les crearem amb l'eina Named Selections. Aquestes etiquetes són necessàries 

per a poder posar les condicions de contorn correctes (Annex D).  

 

Per a crear un nou Named Selection, anirem a la banda esquerra de la pantalla del bloc de mallat de 

l'Ansys Workbench, i clicarem amb el botó dret a sobre Named Selections → Insert → Named 

Selection. Tot seguit a la banda inferior esquerra de la pantalla ens sortirà un quadre de diàleg com el 

que mostra la Figura C17. En aquest quadre de diàleg, a l'únic que hem de clicar és a Geometry,  

després seleccionar la superfície a la que ens interessa fer el Named Selection, i finalment clicar a 

Apply. Automàticament apareixerà a sota de Named Selections una branca que posa Selection. Si 

cliquem sobre Selection amb el botó dret i llavors cliquem a Rename, li podrem donar el nom que 

més ens convingui. 

 

 

Figura C17. Quadre de configuració de Named Selection 

 

En el cas d'estudi, s'han donat sempre els mateixos noms a les mateixes superfícies dels diferents 

casos, perquè alhora de configurar el Setup (Annex D) hi ha una opció que consisteix en guardar els 

paràmetres del Setup per no haver de repetir-los altra vegada amb els diferents casos, eina que 

permet estalviar molta feina. 
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C3.1.- Volum de control gran 

  

Les figures C18, C19 i C20 mostren com s'han anomenat les diferents superfícies del volum de control 

gran, a través de l'eina Named Selections:  

 

 

Figura C18. Named Selections del volum de control gran, part exterior. 

 

Les etiquetes de la Figura C18, corresponen a: 

  

 - Etiqueta A (estatic_ext_sup): Correspon a la tapa superior del volum de control gran, part 

 exterior. 

 - Etiqueta B (estatic_ext_lateral): Corespon a la superfície lateral del cilindre de control gran, 

 part exterior. 

 - Etiqueta C (estatic_ext_inf): Correspon a la tapa inferior del volum de control gran, part 

 exterior. 
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Figura C19. Named Selections del volum de control gran, part interior. 

 

Les etiquetes de la Figura C19, corresponen a: 

  

 - Etiqueta A (estatic_int_sup): Correspon a la tapa superior del volum de control gran, part 

 interior. 

 - Etiqueta B (estatic_int_lateral): Corespon a la superfície lateral del cilindre de control gran, 

 part interior. 

 - Etiqueta C (estatic_int_inf): Correspon a la tapa inferior del volum de control gran, part 

 interior. 
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Figura C20. Named Selections el volum de control gran, mànega. 

 

Les etiquetes de la Figura C20, corresponen a: 

  

 - Etiqueta A (estatic_tub_final): Correspon a la tapa inferior de la mànega, del volum de 

 control gran. 

 - Etiqueta B (estatic_tub_lateral): Corespon a la superfície lateral de la mànega, del volum de 

 control gran. 
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C3.2.- Volum de control petit/turbina  

 

Les figures C21 i C22 mostren com s'han anomenat les diferents superfícies del volum de control 

petit, a través de l'eina Named Selections:  

 

 

Figura C21. Named Selections del volum de control petit, part exterior. 

 

Les etiquetes de la Figura C21, corresponen a: 

  

 - Etiqueta A (mobil_sup): Correspon a la tapa superior del volum de control petit, part 

 exterior. 

 - Etiqueta B (mobil_lateral): Corespon a la superfície lateral del cilindre de control petit, 

 part exterior. 

 - Etiqueta C (mobil_inf): Correspon a la tapa inferior del volum de control petit, part 

 exterior. 
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Figura C22. Named Selections del volum de control petit, part interior (rodet). 

 

L'etiqueta de la Figura C22, correspon a: 

  

 - Etiqueta Rodet (rodet): Correspon a la part interior del volum de control petit (rodet).  
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C3.3.- Doll d'aigua 

 

La figura C23 mostren com s'han anomenat les diferents superfícies del doll d'aigua, a través de l'eina 

Named Selections:  

 

 

Figura C23. Named Selections del doll d'aigua 

 

Les etiquetes de la Figura C23, corresponen a: 

  

 - Etiqueta A (entrada): Correspon a la part superior del doll d'aigua.  

 -Etiqueta B (tub_lateral): Correspon a la part lateral del doll d'aigua. 

 - Etiqueta C (tub_final): Correspon a la part inferior del doll d'aigua. 
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ANNEX D. SETUP DE LA SIMULACIÓ  

AMB CFX 
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D1.- Introducció 

Com aclaració introductòria, és necessari comentar que la configuració de les condicions de contorn 

de cada cas ( Turbina laboratori, Turbina Himàlaia i Turbina Himàlaia àleps modificats) és exactament 

la mateixa. Els pocs paràmetres que varien d'un cas a un altre estan anomenats en cada un dels 

apartats. En el cas que no es digui res, es sobreentén que no hi ha cap modificació entre casos. 

 

D2.- Ordenació de dominis 

 

Per començar a configurar les condicions de contorn, el que s'ha de fer és separar i ordenar els 

diferents dominis. Els dominis són el que nosaltres anomenem volums. El CFX quan importa la malla, 

l'importa com si fos tot un sol volum, per tant, el primer pas és separar aquest volum en els tres 

volums que tenim nosaltres. La Figura D1 mostra la interfície de treball del CFX. Com es pot veure, és 

una estructura molt similar a la de la plataforma de mallar volums (Annex B). 

 

Figura D1. Interfície de treball del programa CFX 



 

Millora del rendiment hidràulic d'una turbina picohidràulica Memòria i annexos 

113 
 

 

Per començar a ordenar els diferents dominis, haurem de clicar amb el botó dret del ratolí sobre  

Flow Analysis 1 → Insert → Domain. Després de clicar, ens sortirà un petit quadre de diàleg on 

haurem de posar el nom que desitgem en el domini que estem creant. El posem i premem intro, i 

llavors ens apareixerà a la part esquerra de la pantalla un quadre de diàleg tal com el que mostra la 

Figura D2.  

 

 

Figura D2. Configuració dels dominis 
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D2.1.-Basic Settings 

El primer pas per a configurar els dominis, és la pestanya Basic Settings, que ens apareix en el quadre 

de diàleg de la Figura D2.  

Per començar, a la finestra on posa Location, haurem de clicar sobre el botó que hi ha tres punts 

suspensius, i seleccionar el nom del volum que haviem definit en el mallador. Per exemple: Si en el 

primer quadre de diàleg li hem posat el nom de "Cilindre estàtic" perquè hem decidit que 

començaríem per el volum de control gros, en quadre que ens surt just després de clicar sobre l'icona 

dels 3 punts suspensius, haurem de clicar sobre "cilindre_estatic" (els noms que trobarem en el 

quadre que apareix després de clicar sobre els 3 punts suspensius, són els noms dels volums que els 

hi hem donat en la plataforma de mallar). 

Un cop ordenat el domini, haurem de repetir el pas amb els 2 dominis següents que ens queden 

(cilindre petit i trajectòria aigua, en aquest cas). Abans de clicar OK per seguir i ordenar els següents 

dominis, s'han d'establir una sèrie de paràmetres en les diferents pestanyes del quadre de diàleg de 

la Figura D2. 

A les següents pestanyes hem d'indicar els següents paràmetres per a tots 3 dominis: 

 -Domain Type: Fluid Domain 

 - Coordinate Frame: Coord 0 

 - Reference Pressure: 1 [atm] 

 - Buoyancy Model → Op9on: Non Buoyant 

 - Mesh deformation → Op9on: None 

 

En el sub-requadre anomenat Fluid and Particle Definitions, s'han de donar d'alta els dos fluids que 

interactuaran a la simulació. Per donar d'alta un fluid cliquem sobre l'icona que té forma d'un full de 

paper, i ens demanarà que li donem un nom, per exemple, "aigua". Llavors, en la pestanya que hi ha 

a sota, anomenada Material, li indiquem Water. I Option → Continous Fluid. Haurem de seguir 

exactament el mateix procés per a donar d'alta l'aire, amb la única diferència que a la pestanya 

Material li haurem d'indicar Air at 25 C. Aquest procediment només serà necessari fer-lo alhora de 

configurar el primer domini, perquè programa dóna per suposat que els diferents dominis 

interactuaran amb els mateixos fluids. 
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Finalment, a la pestanya Domain Motion, haurem d'escollir diferents opcions depenent del domini: 

 - Cilindre gros: Stationary 

 - Cilindre petit: Rotating 

 - Trajectòria aigua: Stationary 

 

En el cas del cilindre petit, quan li indiquem que és rotacional, ens apareixerà una nova pestanya a 

sota, on podrem indicar la velocitat angular a la que gira el rodet. Per cada cas s'han estudiat 

diferents velocitats de gir, en diferents simulacions: 

 - Turbina laboratori: 30, 90, 150, 210, 270, 330 i 390 revolucions per minut. 

 - Turbina real Himàlaia: 30, 90, 150, 210 i 270 revolucions per minut. 

 - Turbina real amb àleps modificats:  90, 150, 210, 270 revolucions per minut. 

 

D2.2.- Fluid Models 

En la segona pestanya de la part superior del quadre de diàleg que ens ha aparegut al crear el nou 

domini, (Fluid Models) haurem de definir més paràmetres de la configuració del nostre experiment. 

La pestanya Fluid Models, té un aspecte tal i com mostra la Figura D3: 

 

Figura D3. Fluid domains 
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Els paràmetres que s'han d'indicar en aquesta part del Setup, són els mateixos per a els 3 dominis: 

 - Multiphase: Homogeneous Model activat 

 - Free Surface Model:  Option None 

 - Heat Transfer: Homogeneous Model desactivat 

  - Option: Isothermal 

  - Fluid Temperature: 25 C 

 - Fluid Turbulence: Option None (Laminar)* 

 - Combustion: Option None 

 - Thermal Radiation: None 

 - Electromagnetic Model: Desactivat 

 

*Laminar: Es va tenir que escollir el flux com a laminar, perquè si escollíem flux turbulent, l'Ansys donava un 

error, i no era possible fer cap simulació. 

 

D2.3.- Fluid Pair Models 

Per seguir amb la configuració del domini, ara ens hem de dirigir a la tercera pestanya superior del 

quadre de diàleg que ens ha aparegut quan hem creat el nou domini. A la pestanya Fluid Pair Models, 

Figura C4, els valors per defecte són correctes, però tot i així, s'han de comprovar per seguretat. Els 

paràmetres pels tres dominis són els mateixos, i han de ser: 

 

 - Aigua | Aire : Surface Tension Coefficient: Desactivat 

 - Interface Transfer: Option : Mixture Model 

 - Interface Len. Scale: 1 [mm] i Minimum Volume Fraction for Area Density: Desactivat 

 - Mass Transfer: Option: None 
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Figura D4. Configuració de Fluid Pair Models 

 

D2.4.- Initialization 

Com a últim pas per a la configuració dels dominis, hem d'anar a la pestanya superior Initialization. La 

pestanya Initialization es mostra a la Figura D5.  

 

Figura D5. Configuració de Initialization 
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En aquesta pestanya els paràmetres per als 3 casos, també han de ser iguals, i han de ser les 

següents: 

 - Domain Initialization: Seleccionat 

 - Coord Frame: Desactivat 

 - Initial Conditions: Velocity Type: Cartesian. 

  - Cartesian Velocity Components: Option: Automatic with Value 

   - U : 0 [m/s] 

   - V : 0 [m/s] 

   - W : 0 [m/s] 

  - Static Pressure: Option: Automatic with Value 

   - Relative Pressure: 0 [Pa] 

 - Fluid Specific Initialization: 

  - Aigua: Initial Conditions: Volume Fraction: Option: Automatic with Value 

   - Volume Fraction: 0 

  - Aire: Initial Conditions: Volume Fraction: Option: Automatic with Value 

   - Volume Fraction: 1 

 

Aquest pas de la configuració serveix per indicar que al principi de la simulació tot el volum és ple 

d'aire. 

 

D3.- Interfases  

Després d'haver ordenat i configurat els diferents dominis, se l'hi ha d'indicar al programa les 

superfícies de contacte (interfases) entre dos volums. Alhora d'indicar les interfases, farem servir els 

Named Selections que hem creat anteriorment (Annex B). De zones de contacte, en el nostre cas, n'hi 

haurà d'haver 5. Les superfícies d'interfase són les que es mostren a la Figura D6. 
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Figura D6. Zones d'interfase 

 

 La Taula D1 mostra els noms que els hi donarem a les interfícies. Els hi donarem uns noms similars 

als de les Named Selections: 

Interfase Nom interfase Dominis i Named Selections que hi intervenen 

1 Interfase_cilindre_inferior estatic_int_inf mobil_inf 

2 Interfase_cilindre_lateral estatic_int_lateral mobil_lateral 

3 Interfase_cilindre_superior estatic_int_sup mobil_sup 

4 Tub_aigua_lateral estatic_tub_lateral tub_lateral 

5 Tub_aigua_sortida estatic_tub_final tub_final 

Taula D1. Superfícies d'interfase 

Per definir aquestes superfícies d'interfase, hem de clicar amb el botó dret del ratolí sobre Interfaces 

→ Insert → Domain Interface. Acte seguit sortirà un petit requadre demanant-nos que li introduïm 

un nom d'interfase, i hi entrarem un dels noms de la Taula D1. Un cop introduït el nom, apareixerà 

un quadre de diàleg com el que mostra la figura D7. 

Interfase 3 

Interfase 1 

Interfase 2 Interfase 5 

Interfase 4 
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Figura D7. Configuració d'interfase 

 

Per a començar configurar les interfases, haurem d'escollir sempre l'opció Interface Type → Fluid 

Fluid. A les interfases hi intervenen 2 dominis diferents (volums) i dues Named Selections, una de 

cada domini. Llavors, haurem d'escollir el primer domini i el Named Selection d'aquest domini que 

correspongui a aquesta interfase, i llavors el segon domini i el Named selection d'aquest segon 

domini corresponent a aquesta interfase.  

Per a fer més entenedor aquest procés, posarem l'exemple de com emplenar les diferents finestres 

del quadre de diàleg de la configuració d'interfases (Figura D7), referent a 

l'Interfase_cilindre_inferior: 

 - Interface Slide 1: 

  - Domain (Filter): estatic   ← 1r domini d'interfase 

  - Region list : estatic_int_inf    ← Named Selection domini "estatic"  

       corresponent a interfase_cilindre_exterior 
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 - Interface Slide 2: 

  - Domain (Filter): mobil    ← 2n domini d'interfase 

  - Region list : mobil_inf    ← Named Seleceon domini "mobil"  

       corresponent a interfase_cilindre_exterior 

 - Interface Models: Option General Connection 

  - Frame Change/Mixing Model:  Transient Rotor Stator * 

 - Pitch Change: Option : None 

 - Mesh Connection Method: Mesh Connection: Option GGI 

  -Intersection Control: Desactivat 

 

* Atenció amb Transient Rotor Stator. Pot ser que no aparegui entre les opcions a escollir. Si no apareix, en l' interfície de 

treball general del CFX, s'ha de clicar amb el botó dret del ratolí sobre Analysis Type → Edit. I a l'opció anomenada Analysis 

Type escollir Transient. Aquest apartat s'explica més extensament a l'apartat C4 Analysis Type d'aquest Annex. 

Per la resta d'interfases, els paràmetres i procés a seguir és el mateix exceptuant els dos dominis i 

Named Selections (que seran els dominis i les Named Selections que corresponguin a la interfase que 

estiguem configurant. Veure Taula D1). L'opció Frame Change/Mixing Model també variarà depenent 

de la interfase: 

 - Interfases 1, 2 i 3: l'opció que escollirem serà Transient Rotor Stator 

 - Interfases 4 i 5: l'opció que escollirem serà None 

 

D4.- Boundaries 

El concepte Boundaries es refereix als límits/fronteres. Ens interessa definir diferents fronteres 

especificant valors de pressió relativa d'aire, per indicar per quina superfície entra l'aigua i a quina 

velocitat i que el rodet és massís.  

En el present cas, haurem de definir 5 boundaries: 

 1.- Cilindre gran: Superfície exterior lateral. Indicarem pressió relativa d'aire. 

 2.- Cilindre gran: Superfície exterior superior. Indicarem pressió relativa d'aire. 

 3.- Cilindre gran: Superfície exterior inferior. Es considerarà com si fos el terra. 
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 4.- Rodet de la turbina:  Indicarem que el rodet és massís. 

 5.- Trajectòria aigua: Superfície superior. Indicarem per on entra l'aigua. 

 

Per generar una nova Boundary, clicarem amb el botó dret sobre el domini corresponent i 

seleccionarem Insert → Boundary. 

 

D4.1.- Boundary 1. Cilindre gran 

Per establir la primera Boundary, clicarem amb el botó dret sobre el domini Cilindre_estatic i li 

indicarem Insert → Boundary. Tot seguit apareixerà un requadre on ens demana que li donem un 

nom. En el present cas s'ha anomenat com a  "paret_lateral". Un cop posat el nom, ens apareixerà un  

quadre de diàleg com el de la Figura D8. 

 

 

Figura D8. Basic settings de la Boundary 

 

En el quadre de diàleg de la Figura D8, a la finestreta Boundary Type seleccionarem Opening. A la 

finestreta Location, hem de clicar sobre l'icone amb els tres punts suspensius, i buscar la Named 

Selection corresponent, en aquest cas: estatic_ext_lateral. Seguidament, clicarem sobre la pestanya 

superior Boundary Details, i el quadre de diàleg quedarà de la forma que mostra la Figura D9. 
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Figura D9. Boundary Details 

En el quadre de diàleg de la Figura D9, els paràmetres han de ser els següents: 

 - Flow Regime: 

   Option: Subsonic  

 - Mass And Momentum:  

  - Option: Opening Pres. and Dirn 

  - Relative Pressure: 0 [Pa] 

 - Flow Direction 

  - Option: Normal to Boundary Condition 

 - Loss Coefficient: desactivat 

 

Finalment, haurem d'anar a la pestanya Fluid Values. Les dues altres pestanyes anomenades Sources i 

Plot Options, els valors que hi ha per defecte són vàlids per al nostre cas. Quan cliquem sobre la 

pestanya Fluid Values, apareixerà un quadre de diàleg com el que mostra la Figura D10. 
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Figura D10. Fluid Values 

En aquest últim apartat, haurem d'indicar que el volum d'aigua és 0, i el volum d'aire és 1. Un cop fet 

tots els passos, haurem de clicar al botó Apply per acabar de generar la Boundary. 

 

D4.2.- Boundary 2. Cilindre gran 

Per establir la segona Boundary, clicarem amb el botó dret sobre el domini Cilindre_estatic i li 

indicarem Insert → Boundary. Tot seguit apareixerà un requadre on ens demana que li donem un 

nom. En el present cas s'ha anomenat com a  "paret_superior".  

A partir d'aquí, el procediment és exactament el mateix que amb la Boundary 1, amb la única 

diferència que a Location hem d'indicar la paret exterior superior del cilindre gran, en el nostre cas 

anomenada "estatic_ext_sup". 

 

D4.3.- Boundary 3. Cilindre gran 

Per establir la tercera Boundary, clicarem amb el botó dret sobre el domini Cilindre_estatic i li 

indicarem Insert → Boundary. Tot seguit apareixerà un requadre on ens demana que li donem un 

nom. En el present cas s'ha anomenat com a  "paret_terra". Un cop posat el nom, ens apareixerà un  

quadre de diàleg com el de la Figura D11. 
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Figura D11. Basic settings de la Boundary 

 

En el quadre de diàleg de la Figura D11, a la finestreta Boundary Type  li indicarem Wall. A la 

finestreta Location, hem de clicar sobre l'icone amb els tres punts suspensius, i buscar la Named 

Selection corresponent, en aquest cas: estatic_ext_inf. Seguidament, clicarem sobre la pestanya 

superior Boundary Details, i el quadre de diàleg quedarà de la forma que mostra la Figura D12. 

 

 

 

Figura D12. Boundary Details 

 

En el quadre de diàleg de la Figura D12 l'únic que hem de comprovar és que a l'opció de Mass and 

Momentum estigui seleccionat No Slip Wall, i Wall Velocity desactivat. 

La pestanya anomenada Sources, els valors que hi ha per defecte són vàlids per al nostre cas. Un cop 

fet tots els passos, haurem de clicar al botó Apply per acabar de generar la Boundary. 
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D4.4.- Boundary 4. Rodet de la turbina 

 

Per establir la Boundary del rodet, clicarem amb el botó dret sobre el domini Cilindre_mobil i li 

indicarem Insert → Boundary. Tot seguit apareixerà un requadre on ens demana que li donem un 

nom. En el present cas s'ha anomenat com a "rodet". Un cop posat el nom, ens apareixerà un  

quadre de diàleg com el de la Figura D13. 

 

 

Figura D13. Basic settings de la Boundary 

 

En el quadre de diàleg de la Figura D13, a la finestreta Boundary Type hem de seleccionar Wall. A la 

finestreta Location, hem de clicar sobre l'icone amb els tres punts suspensius, i buscar la Named 

Selection corresponent, en aquest cas: rodet. I en Frame Type, ha d'estar seleccionat Rotating. 

A partir d'aquí, els valors que hi ha per defecte en les altres pestanyes superiors, són correctes, i per 

tant no haurem de fer cap més configuració. Per acabar de generar la Boundary, clicarem sobre el 

botó Apply, i llavors sobre el botó OK. 

 

D4.5.- Boundary 5. Trajectòria aigua 

 

Per acabar amb les Boundaries, crearem la Boundary que estableix l'entrada d'aigua en el nostre 

experiment. Clicarem amb el botó dret sobre el domini Trajectoria_aigua i li indicarem Insert → 

Boundary. Tot seguit apareixerà un requadre on ens demana que li donem un nom. En el present cas 

s'ha anomenat com a  "sortida_aigua". Un cop posat el nom, ens apareixerà un  quadre de diàleg 

com el de la Figura D14. 
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Figura D14. Basic settings de la Boundary 

 

En el quadre de diàleg de la Figura D14, a la finestreta Boundary Type li indicarem que és un Inlet. A 

la finestreta Location, hem de clicar sobre l'icone amb els tres punts suspensius, i buscar la Named 

Selection corresponent, en aquest cas: entrada. Seguidament, clicarem sobre la pestanya superior 

Boundary Details, i el quadre de diàleg quedarà de la forma que mostra la Figura D15. 

 

 

Figura D15. Boundary Details 

En el quadre de diàleg de la Figura D15, els paràmetres han de ser els següents: 

 - Flow Regime: 

   Option: Subsonic  

 - Mass And Momentum:  

  - Option: Normal Speed 

  - Normal Speed: 11.74 [m/s] 
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La velocitat d'entrada d'aigua a la turbina del laboratori de mecànica de fluids de la Universitat de 

Girona, sabem que és de 11'74 m/s degut a càlculs i estudis previs al present projecte. La velocitat 

d'entrada de l'aigua a la turbina de l'Himàlaia s'estima que és de 10 m/s. 

Finalment, haurem d'anar a la pestanya Fluid Values. Les dues altres pestanyes anomenades Sources i 

Plot Options, els valors que hi ha per defecte són vàlids per al nostre cas. Quan cliquem sobre la 

pestanya Fluid Values, apareixerà un quadre de diàleg com el que mostra la Figura D16. 

 

 

Figura D16. Fluid Values 

 

En aquest últim apartat, haurem d'indicar que el volum d'aigua és 1, i el volum d'aire és 0. Un cop fet 

tots els passos, haurem de clicar al botó Apply i llavors a OK per acabar de generar la Boundary. 
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D5.- Analysis Type 

 

L'apartat Analysis Type és allà a on es definiran els paràmetres temporals de la simulació. Per 

configurar-los, haurem de clicar amb el botó dret del ratolí sobre Analysis Type → Edit. Llavors, ens 

apareixerà un quadre de diàleg com el de la Figura D17. 

 

 

Figura D17. Type Analysis 

Els paràmetres que s'han d'escollir són: 

 - External Solver Coupling: Option: None 

 - Analysis Type: Option: Transient 

 - Time Duration: Option: Total Time: 10 [s] 

 - Time Steps: Option: Time Steps: Timesteps: * [s] 

 - Initial Time: Option: Automatic with Value: Time: 0 [s] 
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* Timesteps: El valor del pas de temps serà diferent depenent de la velocitat de rotació que li 

imposem a la turbina. L'equació que regeix la relació entre Timesteps i Velocitat angular de rotació és 

la que es mostra a la Equació C1. 

 

+, = 	
0′2

6 · .
 

Equació D1. Relació entre Timesteps i Velocitat angular 

 

On:   TS= Timesteps o passos de temps [seg] 

  N= Velocitat angular turbina [rev/min] 

 

L'equació D1 prové de la relació mostrada a la Equació D2. 

 

/Ø = 		$ · 	/+		 → 	/+ =
/Ø

$
 

Equació D2. Relació entre angle girat i velocitat angular per increment de temps 

 

On: ΔØ= Increment d'angle girat [rad] 

 w = velocitat angular [rad/seg] 

 ΔT= Increment de temps o Time-Step [seg] 

 

Com a criteri empíric s'imposa que cada pas sigui de 0'2º. Increments d'aquesta magnitud són 

suficients com per no perdre detall del que està succeint en la simulació. Per tant, substituint 0'2º a 

l'equació D2, i efectuant la taula de conversió de l'Equació D3, aconseguirem trobar l'Equació D1. 

 

/+ =
0.2 ·

22	�	&
360º

.	
�	&
5

·
1	��6
22	�	&

·
60	5�7
1	'��

= 	
0.2 · 60

360.
= 	

0.2

6.
 

 

Equació D3. Factors de conversió per a trobar l'Equació 1 
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Si apliquem aquesta relació de l'Equació D1 a les diferents velocitats que farem les simulacions, 

obtindrem els resultats que mostra la Taula D2. 

 

Revolucions 
per minut 

Pas de 
temps [seg] 

30 0.00111 

90 0.000370 

150 0.000222 

210 0.000158 

270 0.000123 

330 0.000101 

390 0.000085 
Taula D2. Relació velocitat angular - passos de temps 

 

D6.- Solver 

 

El Solver és aquell apartat a on configurarem les variables de la solució que volem que ens doni el 

programa de càlcul.  

 

D6.1.-Output Control 

 

Per començar a configurar les variables que volem que ens doni la solució, haurem de clicar amb el 

botó dret del ratolí a sobre d'Output Control, que està a dins de la branca Solver, de l'interfície de 

treball principal del CFX, i llavors clicar Edit. Ens apareixerà un quadre de diàleg com el que mostra la 

Figura D18. 

 

 

Figura D18. Output settings. 
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Les pestanyes de Results, Backup, Trn Stats i Export, els valors que tenen per defecte són vàlids per a 

el nostre cas. En el nostre cas només s'han de variar les configuracions de Trn Results i Monitor. La 

configuració de Trn Results, és mostrada a la Figura D19. 

 

Dins de Trn Results, s'ha de crear un nou Transient Results, clicant a l'icona en forma de full de paper, 

i anomenar-lo "transient", quan ho demana. Llavors, a dins les opcions que hi ha, s'han de deixar tots 

els valors que hi ha per defecte, i a dins de l'apartat Timestep Interval, escriure 50. 

 

 

Figura D19. Apartat Trn Results de Monitor Control 

 

Llavors haurem d'anar a la pestanya superior anomenada Monitor, i ens apareixerà un quadre de 

diàleg com el que mostra la Figura D20. 
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Figura D20. Apartat Monitor d' Output Control 

 

En aquesta finestra, haurem de seleccionar el quadrat de Monitor Objects. Un cop el seleccionem, 

haurem de crear nous Monitor Points and Expressions. Ho farem clicant la icona que té forma de full 

de paper, i els haurem d'anomenar segons el que vulguem monitoritzar. Llavors a la opció Option, 

haurem de seleccionar Expression, i introduir la formula del que vulguem monitoritzar. La taula D3 

mostra el nom que s'ha donat i les expressions que corresponen: 

 

Què es vol representar Nom que se li ha donat Expressió 

Força X sobre el rodet Force_x force_x()@rodet 

Força Y sobre el rodet Force_y force_y()@rodet 

Força Z sobre el rodet Force_z force_z()@rodet 

Parell X sobre el rodet Torque_x torque_x()@rodet 

Parell Y sobre el rodet Torque_y torque_y()@rodet 

Parell Z sobre el rodet Torque_z torque_z()@rodet 

Taula D3. Relació de variables i equacions a monitoritzar durant la solució 
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Després de configurar tots els paràmetres de l'Output Control, haurem de clicar a sobre el botó Apply 

i després sobre el d'OK. 

 

D6.2.- Expert Parameters 

 

Com a última configuració del Setup, hem de clicar sobre Solver de l'arbre principal de l'interfície de 

treball del CFX, i seleccionar Insert → Expert Parameters. Acte seguit, ens apareixerà a la pantalla, un 

quadre com el que mostra la Figura D21. 

 

 

Figura D21. Expert parameters - Discretisation 

 

La configuració general que hi ha per defecte va bé per a la nostra simulació, amb l'excepció que a 

dins de la pestanya superior anomenada Convergence Control hem d'anar a l'apartat Memory 

Control, seleccionar Topology estimate factor, i de donar-li un valor (Value) d'1'2, tal i com mostra la 

Figura D22. 
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Figura D22. Expert parameters - Convergence Control 

 

Un cop efectuats tots els passos del present Annex, podrem llançar la simulació clicant sobre Solution 

del menú principal de la pantalla principal de l'Ansys Workbench. 
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ANNEX E. SETUP DE LA SIMULACIÓ 

AMB STAR CCM+ 



 

Millora del rendiment hidràulic d'una turbina picohidràulica Memòria i annexos 

137 
 

 

E1.- Introducció 

 

En aquest Annex es mostra com configurar les condicions de contorn de les simulacions amb Star-

CCM+. En aquest Annex es veurà el cas particular de la turbina del laboratori a 90 revolucions per 

minut. Les altres simulacions són idènticament iguals a excepció de les revolucions i algun altre 

paràmetre que s'indicarà més endavant. 

 

E2.- Primers passos i importació de la malla 

 

Per a començar a treballar amb l'STAR-CCM+, hem d'executar el programa fent dos clics sobre la 

icona de l'STAR-CCM+ a l'escriptori dels ordinadors de l'aula CFD de la Universitat de Girona. Un cop 

obert el programa, li haurem d'indicar que volem crear un nou arxiu clicant sobre la icona de la part 

superior esquerra de la pantalla que té forma de full de paper. Quan haguem clicat la icona, 

apareixerà un quadre de diàleg com el que mostra la Figura E1. En aquest quadre de diàleg li haurem 

d'indicar que volem el Run Mode en Serial, i clicar OK. La resta de paràmetres que hi ha per defecte 

ens són vàlids per al nostre cas. 

 

 

Figura E1.- Generació d'una nova simulació amb el programa STAR CCM+ 
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Un cop haguem creat la nova simulació, ens apareixerà l'interfície de treball de l'STAR-CCM+, que és 

la que mostra la Figura E2. 

 

 

Figura E2. Interfície de treball de l'STAR-CCM+ 

 

Com es pot veure, l'interfície de treball de l'STAR-CCM+ es divideix en 4 regions:  

 - Configuració de les condicions de contorn (part superior esquerra) 

 - Representació de volums (part superior dreta) 

 - Propietats (part inferior esquerra) 

 - Missatges i comandes automàtiques (part inferior dreta) 
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La part amb la que treballarem, serà la part de configuració. La Figura E3 mostra amb més detall 

l'estructura de la configuració. 

 

Figura E3. Configuració de les condicions de contorn 

 

Com a primer pas, haurem d'importar la malla que tenim generada amb l'Ansys Workbench (Annex 

C). Per importar-la clicarem sobre File → Import → Import Volume Mesh. Ens sortirà un quadre de 

diàleg a on haurem de seleccionar la carpeta on està la malla, seleccionar la malla i clicar OK. Llavors, 

a la part superior dreta de la interfície de treball apareixeran els volums de la malla. 

 

E3.- Configuració condicions de contorn 

 

Per a configurar les condicions de contorn treballarem amb la part superior esquerra de la interfície 

de treball de l'STAR-CCM+. Per configurar seguirem l'ordre descendent de les carpetes que apareixen 

a la Figura D3. Hi han diverses carpetes, on no s'ha de configurar cap paràmetre, per tant, no 

s'indicarà res al respecte. 
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E3.1.- Continua 

 

Els primers paràmetres que hem de configurar són els de la carpeta Continua. En aquest apartat 

configurarem les condicions físiques del nostre experiment, tals com la gravetat, fluids que 

interactuen, etc. Primerament desplegarem la carpeta Continua, i apareixerà una carpeta 

anomenada Physics 1, despleguem aquesta carpeta i apareixeran tres subcarpetes anomenades 

Models, Reference Values i Initial conditions, tal i com mostra la Figura E4. La única carpeta que 

haurem de configurar és la de Models. Els valors que hi ha per defecte a les altres són vàlids per a el 

nostre cas. 

 

 

Figura E4. Configuració de la carpeta Continua 

 

Per configurar les diferents variables, haurem de clicar amb el botó dret del ratolí sobre la carpeta 

Models, i seleccionar Select Models. Llavors apareixerà un quadre de diàleg com el que es mostra a la 

Figura E5. 
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Figura E5. Configuració condicions físiques 

 

En aquest quadre s'anirà modificant a mesura que seleccionem les propietats. S'han de seleccionar, 

per ordre: Three Dimensional → Implicit Unsteady → Mul9phase Mixture → Eulerian Mul9phase → 

Multiphase Interaction → Volume of Fluid (VOF) → Mul9phase Equation of State → Segregated Flow 

→ Turbulent → Reynolds-Averaged Navier-Strokes → K-Omega Turbulence → SST (Menter) K-Omega 

→ All y+Wall Treatment → Gravity. Un cop seleccionats tots aquests paràmetres, la Figura E5 

quedarà de la forma que mostra la Figura E6. Finalment clicarem Close. 

 

 

Figura E6. Configuració final condicions físiques 
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Un cop seleccionats tots els paràmetres, haurem d'indicar quins fluids interactuaran en la nostra 

simulació, en el nostre cas, dos: Aire i Aigua. Aquests fluids els crearem clicant amb el botó dret del 

ratolí sobre la carpeta Eulerian Phases → New. La carpeta Eulerian Phases es troba a dins de la 

carpeta Eulerian Multiphases de l'arbre principal. Un cop clicat New, apareixerà una subcarpeta amb 

el nom per defecte Phase 1. Si cliquem amb el botó dret sobre la carpeta Phase 1 → Rename, li 

podrem donar el nom que vulguem: Aire o Aigua, depenent del que estiguem creant. Quan li haguem 

donat el nom, desplegarem la carpeta Aire o Aigua, i a sobre la subcarpeta Models clicarem amb el 

botó dret per donar-li les propietats al fluid. Havent clicat, apareixerà un quadre de diàleg com el que 

mostra la Figura E7. 

 

 

Figura E7. Configuració del fluid Aire 

 

En aquest quadre de diàleg, li haurem de donar els següents valors: 

 - En el cas d'Aire: Gas → Constant Density 

 - En el cas d'Aigua: Liquid → Constant Density 

S'han de crear ambdós fluids, Aire i Aigua seguint el mateix procediment que el descrit a l'anterior 

paràgraf. 

 

E3.2.- Regions 

 

Per seguir amb la configuració de les condicions de contorn, haurem de definir les interfases entre els 

3 diferents volums. Per crear una interfase, haurem de desplegar la carpeta Regions, i desplegar les 

carpetes corresponents als 3 dominis que tenim en el nostre cas: cilindre_estatic, cilindre_mobil i 

trajectoria_aigua, tal i com es mostra a la Figura E8. 
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Figura E8. Creació d'interfases 

 

Una vegada desplegades les carpetes que fan referència als volums de control, podrem veure les 

Named Selections que varem crear alhora de fer el mallat (Annex C).  Per crear les interfases, haurem 

de seleccionar dos Named Selections (mantenint la tecla Control del teclat premuda) i clicar amb el 

botó dret del ratolí i indicar Create Interface → In-place. Haurem de crear 5 interfases diferents, tal i 

om mostra la Taula E1. 

 

Interfase Dominis i Named Selections que hi intervenen 

1 estatic_int_inf mobil_inf 

2 estatic_int_lateral mobil_lateral 

3 estatic_int_sup mobil_sup 

4 estatic_tub_lateral tub_lateral 

5 estatic_tub_final tub_final 

Taula E1. Relació d'interfases amb els dominis i Named Selections 
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Un cop creades les diferents interfases, veurem que a l'arbre principal ha aparegut una nova carpeta 

anomenada Interfaces (En aquesta carpeta no s'ha de modificar cap paràmetre). Llavors, haurem de 

donar diferents propietats a cada límit dels volums. Per donar les propietats adients, haurem de 

seleccionar la Named Selection o Interface, i en la part inferior esquerra de la pantalla (Propietats) hi 

ha una pestanya anomenada Type, tal i com mostra la Figura E9. En aquesta pestanya s'haurà de 

seleccionar la propietat adequada.  

 

 

Figura E9. Configuració del tipus de límit 

 

Propietats (Type) que s'han de seleccionar en els diferents elements: 

 

 - Domini cilindre_estatic: 

 

  - estatic_ext_inf: Wall 

  - estatic_ext_lateral: Pressure Outlet 

  - estatic_ext_sup: Pressure Outlet 

  - estatic_int_inf: Wall 

   - estatic_int_inf [In-place]: Internal Interface Boundary (Interfase) 

  - estatic_int_lateral: Wall 

   - estatic_int_lateral [In-place]: Internal Interface Boundary (Interfase) 

  - estatic_int_sup: Wall 

   - estatic_int_sup [In-place]: Internal Interface Boundary (Interfase) 

  - estatic_tub_final: Wall 

   - estatic_tub_final [In-place]: Internal Interface Boundary (Interfase) 
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  - estatic_tub_lateral: Wall 

   - estatic_tub_lateral [In-place]: Internal Interface Boundary (Interfase) 

 

 - Domini cilindre_mobil: 

  

  - mobil_inf: Wall 

   -mobil_inf [In-place]: Internal Interface Boundary (Interfase) 

  -mobil_lateral: Wall 

   -mobil_lateral [In-place]: Internal Interface Boundary (Interfase) 

  - mobil_sup: Wall 

   - mobil_sup [In-place]: Internal Interface Boundary (Interfase) 

  - rodet: Wall 

 

 - Domini trajectoria_aigua: 

 

  - entrada: Velocity Inlet 

  - tub_final: Wall 

   - tub_final [In-place]: Internal Interface Boundary (Interfase) 

  - tub_lateral: Wall 

   - tub_lateral [In-place]: Internal Interface Boundary (Interfase) 

 

Un configurats tots els límits, haurem de definir la proporció d'aire i aigua que tenim al principi de la 

simulació. En aquest apartat només haurem de definir els volums d'aire - aigua a les interfases 

(Boundaries) de pressió (Pressure Outlet) i de entrada de flux (Velocity Inlet). Per configurar la relació 

d'aire - aigua de la primera interfase de pressió anirem a Regions → cilindre_esta9c → Boundaries → 

estatic_ext_lateral → Physics Values → Volume Frac9on → Constant. A la banda inferior esquerra de 

la pantalla, ens apareixerà un quadre de diàleg com el que mostra la Figura E10. 
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Figura E10. Configuració Volume Fraction 

 

A Value, haurem d'indicar que volem [1.0, 0.0], que es refereix, en aquest cas, a tot aire. L'ordre dels 

valors depèn de l'ordre en què haguem creat els fluids. Per exemple, si hem creat primer l'aire i 

després l'aigua, el sentit és [ Aire, Aigua ]. Això es pot comprovar anant a la carpeta Continua → 

Physics 1 → Eulerian Mul9phase → Eulerian Phases, i observar quin és el primer i quin és el segon. 

 

Per configurar la relació d'aire - aigua de la segona interfase de pressió anirem a Regions → 

cilindre_estatic → Boundaries → esta9c_ext_sup → Physics Values → Volume Frac9on → Constant. I 

seguir el mateix procediment que amb la primera interfase, indicant que la fracció és tot aire. 

 

En aquest punt, només quedarà indicar que a l'entrada d'aigua és tot aigua. Per a fer-ho anirem a 

Regions → trajectoria_aigua → Boundaries → entrada → Physics Values → Volume Frac9on → 

Constant, i a la finestra Value li posarem [0.0, 1.0], en aquest cas. 
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A l'entrada de flux, també li haurem d'indicar quina és la velocitat d'entrada de l'aigua. Haurem 

d'anar desplegant carpetes en aquest sentit: 

 

 - trajectoria_aigua → Boundaries → Entrada → Physics Values → Velocity Magnitude → 

    Constant. A dins del quadre de diàleg que apareixerà a la part de propietats, a la finestreta 

    Value li haurem d'indicar la velocitat de l'aigua, en aquest cas 11.74 m/s. 

 

Per indicar que el cilindre_mobil té una rotació respecte l'eix Z, haurem d'anar a l'arbre principal del 

Setup i desplegar la carpeta Tools, llavors s'haurà de clicar amb el botó dret sobre la subcarpeta 

Motions. Llavors li haurem d'indicar New → Rota9on. A la banda inferior esquerra de la pantalla 

apareixerà un quadre de diàleg com el que mostra la Figura E11. 

 

 

Figura E11. Configuració Rotation 

 

A dins de les pestanyes de configuració de Rotation, li haurem d'indicar: 

 -Axis Direction: [0.0, 0.0, 1.0] (Li indiquem que gira respecte l'eix Z) 

 - Axis Origin: [0.0, 0.0, 0.0] (Origen de coordenades) 

 - Rotation Rate: 90 rpm (En aquest cas) 

 

La resta de valors, els que hi ha per defecte ens són vàlids. Un cop generat el nou Motion, haurem 

d'indicar al programa que és el cilindre_mobil qui es mou. Per a fer-ho, haurem de desplegar la 

carpeta Regions → Cilindre mobil → Physics Values → Motion Specification. Dins de la finestreta  
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Motion de la part inferior esquerra de la pantalla, li haurem d'indicar Motion → Rotation, tal i com 

mostra la Figura E12. 

 

 

Figura E12. Motion Specification 

 

E3.3.- Derived Parts 

 

En aquest apartat indicarem els plans allà on volem que es projectin els resultats gràfics un cop 

calculada la solució. Haurem de crear dos plans, un vertical, i l'altre horitzontal. 

 

E3.3.1.- Pla vertical 

 

Haurem de situar un pla vertical paral·lel al pla YZ  de referència, però desplaçat -0.14 m (en aquest 

cas) en la direcció de les X, respecte l'origen de coordenades. Per crear-lo clicarem amb el botó dret 

del ratolí sobre la carpeta Derived Parts → New Part → Sec9on → Plane. Llavors apareixerà el quadre 

de diàleg que mostra la Figura E13.  
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Figura E13. Creació pla paral·lel al pla YZ de referència 

 

 

En el quadre de diàleg hem de prémer el botó que té la X, i indicar-li -0.14, en aquest cas. Llavors 

clicar Create, i Close.  

 

E3.3.2.- Pla horitzontal 

 

El procediment per a crear el pla horitzontal paral·lel al pla XY és el mateix que el de l'apartat E3.3.1. 

En aquest cas hem de clicar sobre el botó que té la Z, i indicar-li que el volem amb un desfasament de 

0, tal i com mostra la Figura E14. Llavors cliquem Create i Close. 
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Figura E14. Creació del pla paral·lel al pla de referència XY 

 

E3.4.- Solvers 

 

A dins de la carpeta Solvers, haurem d'indicar magnitud dels passos de temps de la simulació (Time-

Steps). Haurem de desplegar la carpeta Solvers, i clicar sombre Implicit Unsteady. Llavors, a la part 

inferior esquerra, ens apareixerà un quadre de diàleg com el que mostra la Figura E15. 

 

 

Figura E15. Configuració dels Time-Steps 
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A la finestreta Time-Step, li haurem d'indicar la magnitud del Time-Step, basant-nos en la equació 

dels Time-Steps descrita a l'Annex D. En el cas de 90 revolucions per minut, la magnitud del Time-

Step és de 0.000370 segons. 

 

E3.5.- Reports 

 

La carpeta Reports serveix per indicar quines magnituds volem que es representin en la solució. En la 

nostra solució volem representar 6 magnituds diferents: Forces X, Y i Z, i Moments X, Y i Z.  

Per a generar els reports haurem de clicar sobre la carpeta Reports amb el botó dret del ratolí i 

indicar New Report → Force o Moment, depenent del que estiguem creant en aquest instant. Llavors 

apareixerà una nova branca a sota de Reports, anomenada Force/Moment 1, depenent del que 

haguem escollit. Si cliquem a sobre amb el botò dret del ratolí i indiquem Rename, podrem escriure 

el nom que nosaltres vulguem. 

 

Quan haguem creat el nou Report, a la part de configuració sortirà un quadre de diàleg com el que 

mostra la Figura E16 per a les forces, i com el que mostra la Figura E17 per als moments. 

 

 

Figura E16. Configuració del Report tipus força 
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Figura E17. Configuració del Report tipus moment 

 

Depenent en el cas que ens trobem, la pestanya Axis, l'haurem d'emplenar de la següent manera: 

 - Força/Moment X: [1.0, 0.0, 0.0] 

 - Força/Moment Y: [0.0, 1.0, 0.0] 

 - Força/Moment Z: [0.0, 0.0, 1.0] 

 

En tots els casos, en la pestanya Parts, haurem de seleccionar cilindre_mobil: rodet, perquè és el cos 

del que ens interessa saber les forces. La resta de paràmetres per defecte, ens són vàlids per a el 

nostre cas. 

 

Una vegada generats tots els Reports, haurem de seleccionar els tres reports de forces o moments a 

la vegada (mantenint la tecla Control del teclat premuda) i clicar amb el botó dret del ratolí a sobre 

dels reports i clicar sobre Create Monitor and Plot from Report. Llavors apareixerà un quadre de 

diàleg preguntant-nos si volem un única representació per a tots/es 3 o una per a cada un/a. Li 

indicarem que només volem una única representació (Single Plot). Aquest procediment l'haurem de 

fer tant per les forces com per els moments. D'aquesta forma podrem veure els resultats de les 

iteracions en un gràfic. 

 

Una vegada realitzats tots els passos descrits en el present Annex, podrem llançar la simulació. 
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Les figures E18 i E19 mostren uns dels resultats obtinguts amb l'STAR-CCM+, en el cas de la turbina 

del laboratori, a 90 revolucions per minut. 

 

 

Figura E18. Fracció aire - aigua obtinguda amb l'STAR-CCM+. Turbina laboratori a 90 revolucions per minut 

 

 

Figura E19. Evolució del moment en funció de les iteracions. STAR-CCM+ 
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ANNEX F. OBTENCIÓ DE RESULTATS  

AMB ANSYS WORKBENCH 
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F1.- Introducció 

 

Un cop acabats els càlculs, s'han de representar gràficament i interpretar. El que es mostra en aquest 

Annex, és el cas particular de la turbina del laboratori, a 30 revolucions per minut, i a l'instant de 

temps 0.4444 segons. En els altres casos estudiats pot haver-hi lleugeres modificacions, per exemple 

en la situació física dels plans de representació, com es veurà més endavant.  

 

F2.- Exportació de dades a l'Excel 

 

El primer pas que s'ha de fer, és, en el mateix bloc de càlcul, a sobre la pantalla a on es grafiquen les 

iteracions, Figura F1, i estant a la pestanya User Points, clicar amb el botó dret del ratolí i seleccionar 

Export Plot Data. 

 

 

Figura F1. Bloc de càlcul - Pestanya User Points 
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Llavors, haurem de seleccionar a on volem guardar el document que s'ha generat. Aquest fitxer que 

s'ha generat, és un fitxer amb extensió .CSV. Aquest tipus d'extensió no és usual, però l'Excel 

l'accepta com a format de fulla de càlcul. Tot i així, s'haurà de fer una sèrie de passos per poder llegir 

correctament l'arxiu. En aquest cas s'ha utilitzat l'Excel 2007. Pot ser que els passos siguin 

lleugerament diferents entre diferents versions, però les comandes són les mateixes. El primer pas 

que s'ha de fer és obrir l'Excel. Llavors, s'ha d'anar a la pestanya superior anomenada Datos → 

Obtener datos externos → Desde texto. En aquest moment apareixerà un quadre de diàleg on 

haurem d'anar a buscar l'arxiu que volem obrir. Quan seleccionem l'arxiu apareixerà un quadre de 

diàleg com el que es mostra a la Figura F2. 

 

 

Figura F2. Importació de dades a l'Excel. Pas 1 

 

En aquest quadre de diàleg només hem de clicar Siguiente, i apareixerà el segon quadre de diàleg tal i 

com mostra la Figura F3. 
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Figura F3. Importació de dades a l'Excel. Pas 2 

 

En aquest pas a dins de l'apartat Separadores s'ha d'activar → Tabulación i Coma a la vegada. I ja 

podrem clicar Finalizar, perquè els paràmetres que hi ha per defecte a la següent pantalla són vàlids 

per al nostre cas.  

 

Llavors, com a últim pas, haurem d'anar a la pestanya Inicio → Buscar i Reemplazar, i al quadre de 

diàleg que apareix, haurem de dir que busqui els "." i els canviï per ",". El procediment el mostra la 

Figura F4. 

 

 

Figura F4. Buscar i Reemplazar 
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  Un cop fets tots aquests passos, ja tindrem les dades que ens interessen de les iteracions, tal i com 

hem definit al Setup (Annex D) preparades per a operar amb elles i fer els procediments que siguin 

del nostre interès. 

 

F3.- Representació de resultats 

 

Per a representar els resultats, haurem d'utilitzar l'últim bloc del CFX. En la pantalla principal del 

projecte, clicarem sobre Results, tal i com mostra la Figura F5. Llavors, s'obrirà la plataforma de post 

procés, que és molt similar a la del Setup. 

 

 

Figura F5. Menú principal del CFX 

 

Un cop a dins del bloc de Results, haurem de generar diversos elements per poder visualitzar els 

resultats. Les eines bàsiques per a la visualització de resultats, són les que es mostren a la Figura F6. 

Començant d'esquerra a dreta, els botons permeten visualitzar: vectors (Vector), contorns (Contour), 

línies de corrent (Streamline), trajectòria de partícules (Particle Track) i renderitzat de volums 

(Volume Rendering) respectivament. 

 

 

Figura F6. Eines per a la representació dels resultats 
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Els que utilitzarem són les 3 primeres funcions. Abans d'utilitzar aquestes eines, haurem de fer 2 

plans per a representar els resultats sobre ells. En aquest cas, el primer pla serà paral·lel al pla XY, i 

traslladat 0.01 metres respecte l'origen., i el segon pla serà paral·lel al pla ZY i traslladat -0.14 metres 

respecte l'origen. La raó d'aquestes cotes és per situar els plans just al punt on incideix la trajectòria 

de l'aigua amb l'àlep. En el cas de la turbina real, les cotes variaran lleugerament, perquè les mides 

de la turbina són diferents. 

Els plans els crearem clicant a sobre la icona anomenada Location (està situada immediatament a 

l'esquerra de la icona Vector) i li indicarem que volem crear un nou pla. Li haurem de donar un nom, i 

acte seguit apareixerà el quadre de diàleg que mostra la Figura F7. 

 

 

Figura F7. Quadre de diàleg de creació de pla 

 

En aquest quadre de diàleg li haurem d'indicar: 

 - Domains: All Domains 

 - Method: haurem d'escollir el pla YZ o el XY depenent del pla que estiguem creant 

 - X: és el valor de desfasament respecte l'origen. En aquest cas -0.14. En cada cas ens hem 

 d'assegurar que estigui just enmig del flux d'aigua per una visualització més precisa. 

La resta de pestanyes, en el nostre cas no s'han de modificar. Si ens interessés canviar el color de 

fons del pla per a una millor visualització, podem anar a la pestanya Color, i escollir el color que més 

ens convingui. 
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F3.1.- Contorn aigua 

 

Un cop generats els plans, haurem de crear un nou contorn (Contour). Cliquem sobre el botó de 

contorn, i li indiquem el nom: Contorn Aigua. El que volem representar en aquest contorn, és la 

interacció entre l'aigua i l'aire. Quan li haguem donat el nom, ens apareixerà un quadre de diàleg 

com el que es mostra a la Figura F8. 

 

 

Figura F8. Creació d'un nou contorn 

 

Els valors que li haurem d'indicar, són els que mostra la Figura F8: 

 - Domains: All domains 

 - Locations: Pla XY i Pla ZY. Per seleccionar-los tots dos, mantenir la tecla Control del teclat 

 apretada. 

 - Variable: Aigua.Volume Fraction 

 - Range: Global 

La resta de paràmetres d'aquesta i les altres pestanyes, deixem els que hi ha per defecte.  Si cliquem 

Apply, ens apareixerà una representació com les que mostren les Figures F9 i F10. 
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Figura F9. Fracció aigua - aire corresponent a la turbina del laboratori a 30 rpm. Vista en el pla YZ. 

 

 

Figura F10. Fracció aire - aigua corresponent a la turbina del laboratori a 30 rpm. Vista en el pla XY. 
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F3.2.- Contorn velocitats 

 

Per a visualitzar les velocitats de l'aigua, haurem de crear un nou contorn. Seguirem el mateix 

procediment que el seguit a l'apartat F3.1 d'aquest Annex. Aquest contorn l'anomenarem com a 

"Contorn velocitats". Quan li haguem donat nom, apareixerà el mateix quadre de diàleg que a 

l'apartat F3.1, però ara haurem de configurar-lo diferent, tal i com mostra la Figura F11. 

 

 

Figura F11. Configuració contorn velocitats 

 

La configuració serà la mateixa que mostra la Figura F11: 

 - Domains: All Domains 

 - Locations: Pla XY i Pla ZY. Per seleccionar-los els dos a la vegada, prémer la tecla Control del 

 teclat. 

 - Variable: Aigua. Velocity 
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 - Range User specified 

  Min: 0 m/s   Max: 10 m/s 

 - Boundary Data: Hybrid 

 - Color Scale: Linear 

 - Color Map: Default (Rainbow) 

 - # Contours: 11 

 

La resta de paràmetres d'aquesta i les altres pestanyes, deixem els que hi ha per defecte.  Si cliquem 

Apply, ens apareixerà una representació com les que mostren les Figures F12 i F13. 

 

 

Figura F12. Velocitats de l'aigua corresponents a la turbina del laboratori a 30 rpm, representades en el pla YZ. 
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Figura F13. Velocitats de l'aigua corresponents a la turbina del laboratori a 30 rpm, representades en el pla XY 

 

F3.3.- Forces X, Y i Z 

Per a la representació de les forces que actuen a sobre els àleps, també s'hauran de crear contorns. 

Per generar un contorn, cliquem sobre el botó de contorn, i li donem un nom (Forsa X o Forsa Y o 

Forsa Z). S'ha de posar "Forsa" enlloc de "Força" perquè el programa és americà i no accepta la "Ç" 

com a caràcter. Un cop donat el nom, apareixerà un quadre de diàleg com el que mostra la Figura 

F14. 

 

Figura F14. Configuració contorns forces 
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Haurem de fer un contorn per a cada força, i els haurem de configurar de la següent manera: 

 - Domains: mobil 

 - Location: rodet 

 -Variable: Force X o Force Y o Force Z 

 - Range: Global 

 

Un cop configurats, ens apareixerà una imatge com la que mostra la Figura F15. Aquesta vegada, com 

que li hem dit que ens ho representi sobre el rodet (Location: rodet), ens ho representarà a sobre el  

mateix rodet. 

 

 

Figura F15. Representació de repartiment de forces Y en el cas turbina laboratori, 30 rpm. 
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F3.4.- Línies de corrent 

 

Per representar les línies de corrent de l'aigua, haurem de clicar sobre el botó Streamline, i donar-li 

un nom: Línies corrent. Un cop donat el nom, ens apareixerà un quadre de diàleg com el que mostra 

la Figura F16. 

 

 

Figura F16. Configuració de les Streamlines 

 

En el quadre de diàleg, haurem de introduïr els següents paràmetres: 

 - Type: 3D Streamline 

 -Definition: 

  - Domains: All Domains 

  -Start From: sortida_aigua 

  -Sampling: Equally Spaced 
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  - # of Points: 23 (és suficient) 

 - Variable: Aigua.Superficial Velocity 

 - Boundary Data: Conservative 

 - Direction: Forward 

 - Cross Periodics : Seleccionat 

 

Cliquem el botó Apply, i ens apareixerà una representació com la que mostra la Figura F17. En aquest 

cas, no ens representarà la trajectòria de l'aigua sobre els plans que hem definit, sinó que la definirà 

en 3 dimensions. 

 

 

Figura F17. Línies de corrent en el cas turbina laboratori 30 rpm 
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F3.5.-  Vectors de velocitat 

 

Per a veure els vectors de velocitat, haurem de clicar sobre la icona de Vectors. Li haurem de donar 

un nom: Vector velocitat, i quan li haguem donat, ens apareixerà un quadre de diàleg com el que 

mostra la Figura F18. 

 

 

Figura F18. Configuració de Vectors 

Li haurem d'indicar els següents paràmetres:  

 - Domains: All domains 

 - Definition: 

  - Locations: Pla ZY o Pla XY, depenent d'allà a on ens interessi representar-ho. 

  - Sampling: Vertex 

  - Reduction: Reduction Factor : 1 

 - Variable: Aigua.Velocity 

 - Boundary Data: Hybrid 

 - Projection: None 
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Un cop configurada la pestanya Geometry, haurem de configurar la pestanya Color. La pestanya Color 

és la que mostra la Figura F19. 

 

 

Figura F19. Configuració pestanya Color de l'eina Vector 

 

A la pestanya Color, haurem d'indicar els següents paràmetres: 

 - Mode: Use Plot Variable 

 - Range: User Specified 

  - Min: 0 m/s  - Max: 10 m/s 

 

Finalment, a la pestanya Symbol, li haurem d'indicar els paràmetres que mostra la Figura F20. 

 

 

Figura F21. Paràmetres de la pestanya Symbol de l'eina Vectors 
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 -Symbol: Line Arrow 

 - Symbol Size: 0.1 

 -Normalize Symbols: Activat 

 

Un cop configurats aquests paràmetres ens sortirà una representació dels vectors de velocitat de 

l'aigua, tal i com mostren les Figures F21 i F22. 

 

 

Figura F21. Vectors de velocitat del cas turbina laboratori 30 rpm, representats en el pla YZ que prèviament se li ha donat 

un color més grisós per una millor representació 
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Figura F22. Vectors de velocitat del cas turbina laboratori 30 rpm, vista des del pla XY 
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